# Contents

**Chapter 1 • Overview of SAS Clinical Data Integration** ........................................... 1  
How to Use This Document ................................................................. 1  
What is SAS Clinical Data Integration? ....................................... 1  
Typical Workflow in SAS Clinical Data Integration ...................... 2  
Prerequisites ................................................................. 3  
Recommended Reading ............................................................ 3  

**Chapter 2 • Administering Data Standards** ............................................. 5  
About Data Standards Administration ........................................... 5  
Importing Data Standards Metadata ............................................. 6  
Customizing Data Standard Properties ....................................... 9  
Customizing Data Standard Domain Templates .............................. 10  
Managing Controlled Terminology ............................................... 10  
Managing Data Standard Compliance Checks ................................ 12  
Analyzing Domain Use and Promoting a Custom Domain ................ 20  

**Chapter 3 • Managing Clinical Components** ........................................... 23  
About Clinical Component Management ....................................... 23  
Working with Default Folders ....................................................... 24  
Working with Default Libraries .................................................... 26  
Creating and Defining a Clinical Component ................................ 28  
Modifying Clinical Component Properties .................................. 29  
Deleting a Clinical Component ..................................................... 30  
Monitoring the Statuses of Domains .............................................. 31  
Refreshing a Standard Domain ..................................................... 32  

**Chapter 4 • Working with Domain Data and Metadata** ......................... 35  
About Domain Data and Metadata .................................................. 36  
Creating a Standard Domain ......................................................... 37  
Creating a Custom Domain .......................................................... 38  
Creating a Custom Domain from an Existing Domain .................... 40  
Editing Domain Properties ......................................................... 42  
Editing Domain Column Properties .............................................. 43  
Add a Column to a Domain .......................................................... 43  
Loading Data into Domains .......................................................... 44  
Assessing CDISC SDTM Compliance .............................................. 45  
Reporting on CDISC SDTM Compliance ...................................... 46  
The CDISC-SDTM to CRT-DDS Transformation .............................. 48  
Reporting on the CDISC-SDTM to CRT-DDS Transformation ............ 49  
Working with Data from the CDISC-SDTM to CRT-DDS Transformation . 50  
Running the CDISC-SDTM to CRT-DDS Transformation on Saved Data . 55  
Validating a CRT-DDS define.xml File .......................................... 56  
Reporting on the Validity of a CRT-DDS define.xml File ................. 58  
The Subject Sequence Generator Transformation .......................... 59  

**Chapter 5 • Working with Reports** ..................................................... 61  
About Reports ................................................................. 61  
Running and Saving a Report ....................................................... 61  

**Appendix 1 • Adding Users to the Clinical Administrator Group** .............. 63
Chapter 1
Overview of SAS Clinical Data Integration

How to Use This Document

For an overview of SAS Clinical Data Integration features, see Chapter 1, “Overview of SAS Clinical Data Integration,” on page 1.

For tasks that are typically performed by clinical administrators, see Chapter 2, “Administering Data Standards,” on page 5.

For tasks that are typically performed by trial managers, see Chapter 3, “Managing Clinical Components,” on page 23.

For tasks that are typically performed by clinical programmers or data managers, see Chapter 4, “Working with Domain Data and Metadata,” on page 35.

For information about giving a user clinical administration privileges, see Appendix A1, “Adding Users to the Clinical Administrator Group,” on page 63.

For information about troubleshooting and repairing clinical objects, see Appendix A2, “Repairing Clinical Objects,” on page 65.

For information about icons provided by the SAS Clinical Data Integration, see Appendix A3, “SAS Clinical Data Integration Icons,” on page 67.

What is SAS Clinical Data Integration?

SAS Clinical Data Integration supports the pharmaceutical-industry needs for transforming, managing, and verifying the creation of industry-mandated data standards such as those created by Clinical Data Interchange Standards Consortium (CDISC). SAS Clinical Data Integration relies on SAS Data Integration Studio to provide centralized
metadata management using the SAS Metadata Server and the tools that it provides to visually transform data. SAS Clinical Data Integration enhances its usability by adding new metadata types, plug-ins, and wizards. These enhancements help you perform clinically oriented tasks such as importing data standards, creating studies and submissions, and adding specialized transformations for mapping clinical data into a standard data model. SAS Clinical Data Integration leverages the SAS Clinical Standards Toolkit to provide validation and conformance checking.

SAS Clinical Data Integration enables you to:
- improve the consistency of submissions and studies
- improve the long-term management and growth of data
- use data standards effectively
- use a centralized SAS Metadata Server
- use the powerful and user-friendly features of SAS Data Integration Studio to manage metadata, generate and execute SAS Clinical Standards Toolkit code, and visualize the results

Typical Workflow in SAS Clinical Data Integration

Overview

The features and functionality provided by SAS Clinical Data Integration enables the following workflow:

1. Import a data standard and controlled terminology.
2. Create studies and submissions (clinical components).
3. Define domains.
4. Standardize and validate data.
5. Monitor the progress of the definition of clinical domains.
6. Analyze data standard use across clinical components.

Workflow Owners

Typically, different people own different tasks in the workflow. However, ownership can vary depending on the company, and a person might perform tasks in more than one capacity. The following user definitions explain the typical owners and their tasks in the workflow.

Data standards administrator
defines and manages data standards. Analyzes how data standards are implemented by programmers. Data standards administrators can view trends about how a domain is used by programmers. These trends might identify a new column to add to a domain, or point to a custom domain that you should promote into the standards.

Trial manager
defines studies and submissions, defines authorization, and sets the defaults that programmers use when defining content. Setting defaults ensures that programmers use the correct version of the data standards.
Clinical programmer and data manager creates standard and custom domains, writes jobs to extract and transform data into domains, and writes jobs to validate compliance of domains to a data standard.

Prerequisites

SAS Clinical Data Integration 2.2 has the following prerequisites:

- All prerequisites for SAS Data Integration Studio 4.21 must be met.
- SAS Clinical Data Integration 2.2 must be installed.
- SAS Clinical Standards Toolkit 1.3 or later must be installed on the SAS Clinical Data Integration Workspace Server.

Recommended Reading

For the following documentation, see the SAS Customer Support Web site at http://support.sas.com.

- SAS and the Clinical Data Interchange Standards Consortium (CDISC) at http://www.sas.com/industry/life-sciences/cdisc/
Chapter 2
Administering Data Standards

About Data Standards Administration
SAS Clinical Data Integration enables you to centrally define and manage data standards. You can also analyze how data standards are implemented by programmers. For example, you can view trends about how a domain is used by programmers. These trends might identify a new column to add to a standard domain because programmers are often adding the column during conversion. These trends might point to frequently created custom domains that should be promoted into the standards.
Typical user tasks include:
- Import data standards.
- Customize data standards.
- Manage controlled terminology.
- Manage compliance checks.
- Analyze the use of data standards.

### Importing Data Standards Metadata

**Problem**

You want to define studies using a CDISC standard or a data standard from your company.

**Solution**

If you want to use a CDISC standard, use the Import Wizard to import data standard metadata from the SAS Clinical Standards Toolkit. Importing the metadata enables you to update your environment with new releases of data standards from CDISC. CDISC data standards are provided with the SAS Clinical Standards Toolkit. For more information, see the *SAS Clinical Standards Toolkit: User's Guide*.

If you want to use a data standard from your company, then use the SAS Clinical Standards Toolkit to define the data standard. Then, import the data standard.

*Note*: You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix A1, “Adding Users to the Clinical Administrator Group,” on page 63.

**Tasks**

To import data standards metadata, complete the following steps:

1. In SAS Data Integration Studio, display the Clinical Administration tree. Right-click **Data Standards**, and then select **Import**.
   
   The Import Wizard opens. The Select Metadata Source page appears.

2. Select the metadata source to use (for example, **Clinical Data Standards Toolkit**). Then, click **Next**.
   
   The Default Application Server page appears if this is your first time using the Import Wizard. Select one of the application servers that are listed. If you are unsure about which application server to pick, then contact your SAS installation representative. Otherwise, the Select Data Standard Type page appears.

3. Select the data standard type to use (for example, **CDISC-SDTM**). Then, click **Next**.
   
   The Select Data Standard Version page appears.

4. Select the data standard version to use. The CDISC standards that are listed are in the form of the standard short name, followed by the standard version number. (For example, for SDTM 3.1.2, SDTM is the standard short name, and 3.1.2 is the standard version number). Each standard listing might also include a revision number that
indicates the SAS Clinical Standards Toolkit version from which the standard definition was taken (for example, SDTM 3.1.1 (1.2)). Click Next.

The Define General Properties page appears.

5. Edit the default values.
   a. In the Name field, enter a name to replace the default name.
      Note: It is a best practice not to include spaces in the data standard name.
   b. In the Description field, edit the description. In the Formal Name field, enter a more descriptive name for the data standard. This step is optional.
   c. In the Identifier field, specify a text value that uniquely identifies the data standard in metadata. A default value is provided. The value that you enter is verified as unique before you continue.
   d. In the Type list, select a type. The values in this list are set up by your system administrator. These values are important when using the data standards metadata in the SAS Clinical Standards Toolkit. If the required type is not in the list, then you should contact your system administrator to add the type, especially if the data standard is using the SAS Clinical Standards Toolkit. For more information about adding types, see “Customizing Data Standard Properties” on page 9. If the data standard does not use the SAS Clinical Standards Toolkit, then any value can be selected.
   e. In the Version field, enter additional text or accept the default value.
   f. In the Vendor field, enter a vendor value. This step is optional.

6. Click Next.

The Verify Domain Properties page appears.

7. Edit the domain property values. This step is optional.
   Note: Domain properties are an advanced feature in SAS Clinical Data Integration. If you are uncertain about what domain property values to select, then accept all of the default values.

8. Click Next. The Verify Domain Column Properties page appears.

9. Edit the domain column property values. This step is optional.

10. Click Next.
    • If the data standard supports validation, then the Validation Library page appears. Go to step 11 on page 7.
    • If the data standard does not support validation, but does support a data model, then the Verify Column Groups page appears. Go to step 13 on page 8.
    • If the data standard does not support validation or a data model, then the Verify Domain Metadata page appears. Go to step 14 on page 8.

      Note: For more information about SAS libraries, see the SAS Data Integration Studio: User's Guide.

11. On the Validation Library page, select a library or create a new library. For more information about SAS libraries, see the SAS Data Integration Studio: User's Guide.
    Note:
    • You must have appropriate permissions for the selected library. For more information about permissions, see SAS Management Console: Guide to Users and Permissions.
• The path for the selected library must exist.
• The library metadata object is created immediately. Even if you close the Import Model wizard, then the library will remain.

12. Click Next.
• If the data standard supports a data model, then the Verify Column Groups page appears. Go to step 13 on page 8.
• If the data standard does not support a data model, then the Verify Domain Metadata page appears. Go to step 14 on page 8.

13. On the Verify Column Groups page, review the column groups that are defined in the data standard. The Verify Column Groups page is refreshed with detailed information about the columns that are defined in the data standard. After you review this information, click Next.

The Verify Domain Metadata page appears.

14. On the Verify Domain Metadata page, review the domain templates that are defined in the data standard.

Note: This information is provided only as a reference. It enables you to review the metadata before storing it. You cannot make changes to this information. If you see problems in the metadata, then contact whomever is responsible for registering the data standard in the SAS Clinical Standards Toolkit.

15. Click Next.

The Verify Domain Column Metadata page appears.

16. On the Verify Domain Column Metadata page, review the columns that are defined in the data standard.

Note: This information is provided only as a reference. It enables you to review the metadata before storing it. You cannot make changes to this information. If you see problems in the metadata, then contact whomever is responsible for registering the data standard in the SAS Clinical Standards Toolkit.

17. Click Next.

The summary page appears.

18. On the summary page, review the summary. To make changes, click Back. To cancel the changes without saving them, click Cancel. To save the changes, click Finish.

If supported by the data standard, then domain templates, column groups, and validation data sets are displayed in the Data Standards folder in the Clinical Administration tree. For example, if you select the CDISC-SDTM data standard type and version 3.1.1, then the domain templates (SDTM domains), column groups (SDTM classes), and validation data sets (compliance checks) are displayed in a folder that is named what you entered in the Name field.

By default, an imported data standard has a status of Inactive. This status enables you or a data standards administrator to review the template and make changes before releasing it for general use. When you or the data standards administrator is satisfied with the template, you can change its status to Active. Active templates are available for general use.

To make a data standard available for general use, complete the following steps:

1. In SAS Data Integration Studio, display the Clinical Administration tree. Expand Data Standards.

2. Right-click the data standard that you want to activate, and select Properties.
3. In the Data Standard Properties dialog box, click the Properties tab. In the Active field, change false to true. Click OK.

---

Customizing Data Standard Properties

**Problem**

You want to make changes to the properties of a data standard.

**Solution**

SAS Clinical Data Integration provides a common property model. This model defines the properties about which metadata can be collected. These properties are derived from CDISC data standards, but they are implemented so that you can customize how they are used. For example, if a data standard does not use a property, then you can turn that property off. You can adjust or expand the allowable values for a property.

Use the Edit Property Model Defaults dialog box to make your changes. You can add constraints around the content, such as minimum and maximum values, lengths, and default value. For CDISC data standards, SAS Clinical Data Integration loads all of the CDISC information for you based on the SAS interpretation of the data standard. However, interpretations can vary. The Edit Property Model Defaults dialog box provides the flexibility that enables you to apply your own interpretation.

These property values are inherited by newly created instances of the data standard template.

*Note:* You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix A1, “Adding Users to the Clinical Administrator Group,” on page 63.

**Tasks**

To view and edit a property model, complete the following steps:

1. In the Clinical Administration tree, right-click on a clinical object that you want to edit (for example, Data Standards, or in the Clinical Components folder, Study or Submission.

2. Click Edit Property Model. The Edit Property Model Defaults dialog box appears.

3. Select a property in the Properties list. The associated values are displayed to the right of the list. If Use Lookups is selected, values are displayed in the Lookup Value list.

4. To change the default value, select the Default Value list, and make a selection.

5. If the property uses lookups, then you can customize the default values for the property. You must select Use Lookups to enable customization.
   - To add a value, enter the value in the Lookup Value field. Click Save.
   - To edit an existing value, select a value from the area under Lookup Value. That value is displayed in the Lookup Value field. Edit the value in this field, and then click Save. The new value is displayed in the area under Lookup Value.
Customizing Data Standard Domain Templates

**Problem**

You want to make changes to the domain templates for the data standard.

**Solution**

Customize domain clinical properties and domain column clinical properties:

- To change domain template metadata, see “Editing Domain Properties” on page 42.
- To change domain template column metadata, see “Editing Domain Column Properties” on page 43.

Managing Controlled Terminology

**Overview**

SAS Clinical Data Integration enables you to manage controlled terminology. *Controlled terminology* is a set of possible values for something. For example, controlled terminology for the valid values of yes and no could be expressed as (1-Yes, 2-No).

A *terminology table* is a SAS data set that contains controlled terminology data. SAS Clinical Standards Toolkit provides CDISC terminology tables.

A *terminology package* is a group of terminology tables. The data standards administrator creates terminology packages. The data standards administrator manages the granularity of the terminology and the groups to which the terminologies are available. For example, the following is the granularity of the terminology and the group to which it is available:

- a clinical component
- the transformations that use the controlled terminology

When a new study or submission is created, the trial manager selects the terminology package to use for the study or submission. This information is used by the CDISC-SDTM compliance transformation and the SDTM to CRT-DDS transformation.

**Problem**

You want to import a SAS Clinical Standards Toolkit terminology package.

**Solution**

SAS Clinical Standards Toolkit provides CDISC terminology packages. You can import these terminology packages using the Import Wizard.
After a terminology table is imported, you can verify that the import was successful. You can open, delete, or rename the terminology table using SAS Data Integration Studio. For more information, see *SAS Data Integration Studio: User's Guide*.

You can use the New Terminology Package wizard to create new terminology packages. If you want to rename the terminology package, or change the order in which the terminology tables in the package are applied during a transformation, then use the Controlled Terminology Properties dialog box.

SAS Clinical Data Integration provides the following ways to manage your terminology packages:

- “Import Controlled Terminology from SAS Clinical Standards Toolkit” on page 11
- “Create a New Terminology Package” on page 11
- “Edit a Terminology Package” on page 12

*Note:* You must have the appropriate permissions to view the Clinical Administration tree. For more information, see *Appendix A1, “Adding Users to the Clinical Administrator Group,”* on page 63.

**Tasks**

**Import Controlled Terminology from SAS Clinical Standards Toolkit**

To import a terminology table from SAS Clinical Standards Toolkit, complete the following steps:

1. In the Clinical Administration tree, right-click **Data Standards**, and then select **Import**. The Import Wizard opens. The Select Metadata Source page appears.

2. Select **Clinical Data Standards Toolkit**, and then click **Next**. The Select Data Standard Type page appears.

3. Select the data standard terminology to import (for example, “CDISC-TERMINOLOGY”. Click **Next**. The Select Data Standard Version page appears.

4. Select the data standard version to use. Click **Next**. The Terminology Library page appears.

5. In the **SAS Library** list, select the library that will contain the imported terminology table.

   *Note:* The selected library must have the Create Metadata permission enabled.

6. Click **Next**. The Terminology Datasets Folder page appears.

7. In the Folders tab, select the metadata folder that will contain the terminology table. Click **Next**. The summary page appears.

8. Click **Finish**.

**Create a New Terminology Package**

To create a new terminology package, complete the following steps:


2. In the **Name** field, enter a name for the new terminology package. In the **Version** field, enter the version number for the terminology package. In the **Description** field, enter
a description. The version and description are optional. Click Next. The Terminology Sets page appears.

3. Click Add to add the data sets that contain the terminology tables. The Add Terminology Sets wizard opens. The Source Library page appears. For more information about the Add Terminology Sets wizard, see the SAS Data Integration Studio: User's Guide.

4. In the SAS Library list, select the library that contains the terminology table that you want to use. Click Next. The Source Terminology Tables page appears.

5. In the Tables in the library list, select the terminology table or tables that you want to add. You can add one table up to the total number of tables that appear in the list. The tables can be either imported from the SAS Clinical Standards Toolkit or they can be your own terminology tables.

6. Click Finish. This action exits the Add Terminology Sets wizard and returns to the New Terminology Package wizard.

7. Click Finish. The new terminology package is displayed in the Controlled Terminology folder.

**Edit a Terminology Package**

To view, change, or rename the terminology package, complete the following steps:

1. In the Clinical Administration tree, expand Controlled Terminology.

2. Right-click on the terminology package that you want to view, change, or rename, and then select Properties. The Controlled Terminology Properties dialog box appears. In this dialog box, you can rename the package, change the version number and permissions, add a description or notes, or change the order of the terminology tables, to name a few functions. Changing the order of the terminology tables affects the order in which the terminology tables are applied during a transformation.

3. Click OK.

---

**Managing Data Standard Compliance Checks**

**Overview**

A set of compliance checks can be associated with each data standard. The data standards administrator can add new compliance checks, and customize existing compliance checks for a data standard with which he or she is working. Using these checks, you can validate a clinical domain to determine whether it complies with the data standard. Validation is performed by running a job that contains the CDISC-SDTM Compliance transformation.

The data standards administrator can customize validation for a data standard in the Manage Compliance Checks wizard. A compliance check can have an Active or Draft status. In the CDISC-SDTM Compliance transformation, where compliance checks are applied to clinical domains, non-administrator users can select and use only compliance checks that have an Active status. Only administrators can use compliance checks that have a Draft status. The Draft status enables administrators to set up and run compliance transformations to verify custom compliance checks. When an administrator is satisfied with the compliance check, the administrator changes the status to Active, and then the check is available to all clinical programmers.
Problem

You want to manage the compliance checks for your data standard.

Solution

If you have administrator permission, then SAS Clinical Data Integration enables you to:

• “View Compliance Checks” on page 13
• “Create a Customized Compliance Check” on page 13
• “Edit an Existing Compliance Check” on page 16
• “Change the Compliance Check Status” on page 19
• “Delete a Compliance Check” on page 20

Note: You must have the appropriate permissions to view the Clinical Administration tree. For more information, see Appendix A1, “Adding Users to the Clinical Administrator Group,” on page 63.

Tasks

View Compliance Checks

To view compliance checks, complete the following steps:

1. In the Clinical Administration tree, expand Data Standards. Right-click on the data standard that contains the compliance checks that you want to view. Select Manage Compliance Checks. The Manage Compliance Checks wizard opens.

   Note: If the data standard does not support compliance checking, or it does not have a compliance check installed, then a message is displayed.

2. By default, the Available checks table displays details for each compliance check. To view only the Check ID and Description columns, clear the Show details check box.

   Note: You can sort the table by clicking on any column heading.

Create a Customized Compliance Check

The SAS Clinical Standards Toolkit provides a set of compliance checks for the data standards that support validation. SAS Clinical Data Integration imports these compliance checks when you import your data standards. You can create additional compliance checks and add them to the set. For more information about compliance or validation, see the SAS Clinical Standards Toolkit: User's Guide.

The syntax for the following settings is determined by SAS Clinical Standards Toolkit:

• Domain and domain column specifications
• Code source
• Terminology lookup and reporting

SAS Clinical Standards Toolkit is invoked by the SAS code that is generated from a compliance transformation using a check. For more information about the SAS Clinical Standards Toolkit, see SAS Clinical Standards Toolkit: User's Guide.
To create a customized compliance check, complete the following steps:

1. In the Manage Compliance Checks wizard, right-click on a compliance check. Select Customize. The Customize Compliance Check wizard opens. The Check Properties page appears. Most fields on this page default to the values that are used in the selected compliance check.

2. On the Check Properties page, edit the values required for your customization.
   a. In the **Check ID** field, enter an ID that contains at least one non-whitespace character, but no more than 8 characters. All characters except single and double quotation marks are permitted. The ID must be unique among all check IDs for any compliance check belonging to that data standard.
   b. In the **Check Type** list, select or enter a check type that contains at least one non-whitespace character, but no more than 20 characters. All characters except single and double quotation marks are permitted.
   c. In the **Severity** list, select or enter a severity that contains at least one non-whitespace character, but no more than 40 characters. All characters except single and double quotation marks are permitted.
   d. In the **Description** field, enter a description that contains at least one non-whitespace character, but no more than 500 characters. All characters are permitted, but you cannot use single and double quotation marks together in the description. You can use only single quotation marks or only double quotation marks.
   e. In the **Initial Status** list, the default is always Draft.
      
      *Note:* After you test this check using the compliance transformation, you can set the status to Active.

3. Click Next. The Domains page appears.
   
   *Note:* If the Next and Finish buttons are dimmed, then one or more of the values on this page are not valid. Review the criteria for each value, and make any applicable corrections.

4. Edit the values required for your customization.
   
   *Note:* To enable the Domain Specification field for editing, and disable the Domains Referenced table, select the Direct Edit (Advanced) check box.
   a. In the Domains Referenced table, you can edit a row to adjust the values for the domain.
      
      *Note:* The Domains Referenced table might not be displayed depending on the type of compliance check that you have selected.
   b. In the **Domain Specification** field, edit the full domain specification string that is passed to SAS Clinical Standards Toolkit.
      
      *Note:* If the domain specification string is not valid, then the Next and Finish buttons are dimmed. A domain specification string might not be valid in the following situations:
      
      - Brackets are mismatched.
      - Characters are not letters (A, B, C, . . . , Z), digits (0 to 9), or underscores.
      - Special characters, except for the underscore, are included.
5. Click Next. The Domain Columns page appears.

   Note: If the Next and Finish buttons are dimmed, then one or more of the values on this page are not valid. Review the criteria for each value, and make any applicable corrections.

6. Edit the values required for your customization.

   Note: To enable the Column Specification field for editing, and disable the Columns Referenced table, select the Direct Edit (Advanced) check box.

   a. In the Columns Referenced table, you can edit a row to adjust the values for the column.

      Note: The Columns Referenced table is displayed only when the column specification includes one or more column IDs or column specifiers.

   b. In the Column Specification field, edit the full column specification string that is passed to the SAS Clinical Standards Toolkit.

      Note: If the column specification string is not valid, then the Next and Finish buttons are dimmed. A column specification string might not be valid in the following situations:

         • Brackets are mismatched.
         • Characters are not letters (A, B, C, . . . , Z), digits (0 to 9), or underscores.
         • Special characters, except for the underscore, are included.
         • The _ALL_ syntax specifier is included.
         • The length exceeds 200 characters.

7. Click Next. The Check Code page appears.

   Note: If the Next and Finish buttons are dimmed, then one or more of the values on this page are not valid. Review the criteria for each value, and make any applicable corrections.

8. Edit the values required for your customization.

   Note: To enable the Code Source list for editing, and disable the Code field, select the Direct Edit (Advanced) check box.

   a. In the Code Source list, you can select a macro provided by the SAS Clinical Standards Toolkit. The value must contain at least one non-whitespace character, but no more than 32 characters. All characters except single and double quotation marks are permitted. This step is required.

      Note:
      • The Code Source list is displayed only when the column specification includes one or more column IDs or column specifiers.
      • For more information about selecting a macro, see the SAS Clinical Standards Toolkit: User's Guide.

   b. In the Code field, edit the code string that is passed to the SAS Clinical Standards Toolkit. SAS Clinical Data Integration does not validate the syntax in this code string. However, it does validate for the following criteria:

      • The code string contains no more than 2000 characters.
• All characters are permitted, but you cannot use single and double quotation marks together in the description. You can use only single quotation marks or only double quotation marks.

**Note:** Any code that you enter must be consistent with the selected code source. You must enter valid SAS code.

9. Click **Next**. If the compliance check includes a terminology lookup, then the Controlled Terminology Lookup page appears.

**Note:** If the **Next** and **Finish** buttons are dimmed, then one or more of the values on this page are not valid. Review the criteria for each value, and make any applicable corrections.

10. If a terminology lookup is included in the compliance check, then edit the values required for your customization.

**Note:** To enable the **Lookup Type** and **Lookup Source** lists for editing, select the **Direct Edit (Advanced)** check box.

a. In the **Lookup Type** list, you can select or enter the type of terminology lookup. SAS Clinical Data Integration does not validate whether the type exists. The value must contain at least one non-whitespace character, but no more than 20 characters. All characters except single and double quotation marks are permitted. This step is required.

b. In the **Lookup Source** list, you can select or enter the source of the terminology lookup. SAS Clinical Data Integration does not validate whether the source exists. The value must contain at least one non-whitespace character, but no more than 20 characters. All characters except single and double quotation marks are permitted. This step is required.

11. Click **Next**. The Reporting Options page appears.

**Note:** If the **Next** and **Finish** buttons are dimmed, then one or more of the values on this page are not valid. Review the criteria for each value, and make any applicable corrections.

12. Edit the values required for your customization.

**Note:** To enable the **Error Message** field for editing, select the **Direct Edit (Advanced)** check box.

a. Select the **Report All Violations** check box to specify that all violations for the compliance check should be reported every time the validation is run. If you clear this check box, then only the first violation is reported.

b. In the **Error Message** field, specify the text to write to the data set when a violation is detected. You can use substitution variables in this field. The text must contain at least one non-whitespace character, but no more than 500 characters. All characters except single and double quotation marks are permitted.

13. Click **Finish**.

**Note:** If the **Next** and **Finish** buttons are dimmed, then one or more of the values on this page are not valid. Review the criteria for each value, and make any applicable corrections.

**Edit an Existing Compliance Check**

You only can edit compliance checks that have a Draft status. To set the status of a compliance check to Draft, right-click on the compliance check, and select **Make Draft**. To edit an existing compliance check, complete the following steps:
1. In the Manage Compliance Checks wizard, right-click on a compliance check. Select **Edit**.

   The Edit Compliance Check wizard opens. The Check Properties page appears. Most fields on this page default to the values that are used in the selected compliance check.

2. On the Check Properties page, edit the values required for your customization.
   
   a. In the **Check Type** list, select or enter a check type that contains at least one non-whitespace character, but no more than 20 characters. All characters except single and double quotation marks are permitted.

   b. In the **Severity** list, select or enter a severity that contains at least one non-whitespace character, but no more than 40 characters. All characters except single and double quotation marks are permitted.

   c. In the **Description** field, enter a description that contains at least one non-whitespace character, but no more than 500 characters. All characters are permitted, but you cannot use single and double quotation marks together in the description. You can use only single quotation marks or only double quotation marks.

   d. In the **Initial Status** list, the default is always **Draft**.

3. Click **Next**. The Domains page appears.

   **Note:** If the **Next** and **Finish** buttons are dimmed, then one or more of the values on this page are not valid. Review the criteria for each value, and make any applicable corrections.

4. Edit the values required for your customization.

   **Note:** To enable the **Domain Specification** field for editing, and disable the **Domains Referenced** table, select the **Direct Edit (Advanced)** check box.

   a. In the **Domains Referenced** table, you can edit a row to adjust the values for the domain.

      **Note:** The **Domains Referenced** table is displayed only when the domain specification for the compliance check that you are editing includes one or more domain IDs or domain specifiers.

   b. In the **Domain Specification** field, edit the full domain specification string that is passed to the SAS Clinical Standards Toolkit.

      **Note:** If the domain specification string is not valid, then the **Next** and **Finish** buttons are dimmed. A domain specification string might not be valid in the following situations:

      - Brackets are mismatched.
      - Characters are not alphanumeric.
      - The following specifiers are included: +, -, *, _ALL_, :.
      - The length exceeds 200 characters.

5. Click **Next**. The Domain Columns page appears.

   **Note:** If the **Next** and **Finish** buttons are dimmed, then one or more of the values on this page are not valid. Review the criteria for each value, and make any applicable corrections.

6. Edit the values required for your customization.
Note: To enable the Column Specification field for editing, and disable the Columns Referenced table, select the Direct Edit (Advanced) check box.

a. In the Columns Referenced table, you can edit a row to adjust the values for the column.

Note: The Columns Referenced table is displayed only when the column specification for the compliance check that you are editing includes one or more column IDs or column specifiers.

b. In the Column Specification field, edit the full column specification string that is passed to the SAS Clinical Standards Toolkit.

Note: If the column specification string is not valid, then the Next and Finish buttons are dimmed. A column specification string might not be valid in the following situations:

• Brackets are mismatched.
• Characters are not alphanumeric.
• The following specifiers are included: +, -, *, _ALL_, :.
• The length exceeds 200 characters.

7. Click Next. The Check Code page appears.

Note: If the Next and Finish buttons are dimmed, then one or more of the values on this page are not valid. Review the criteria for each value, and make any applicable corrections.

8. Edit the values required for your customization.

Note: To enable the Code Source list and the Code field for editing, select the Direct Edit (Advanced) check box.

a. In the Code Source list, you can select a macro provided by the SAS Clinical Standards Toolkit. The value must contain at least one non-whitespace character, but no more than 32 characters. All characters except single and double quotation marks are permitted. This step is required.

Note: The Code Source list is displayed only when the column specification includes one or more column IDs or column specifiers.

b. In the Code field, edit the code string that is passed to the SAS Clinical Standards Toolkit. SAS Clinical Data Integration does not validate the syntax in this code string. However, it does validate for the following criteria:

• The code string contains no more than 2000 characters.
• All characters are permitted, but you cannot use single and double quotation marks together in the description. You can use only single quotation marks or only double quotation marks.

Note: Any code that you enter must be consistent with the selected code source. You must enter valid SAS code.

9. Click Next. If the compliance check includes a terminology lookup, then the Controlled Terminology Lookup page appears.

Note: If the Next and Finish buttons are dimmed, then one or more of the values on this page are not valid. Review the criteria for each value, and make any applicable corrections.

10. If a terminology lookup is included, then edit the values required for your customization.
Note: To enable the **Lookup Type** and **Lookup Source** lists for editing, select the **Direct Edit (Advanced)** check box.

a. In the **Lookup Type** list, you can select or enter the type of terminology lookup. SAS Clinical Data Integration does not validate whether the type exists. The value must contain at least one non-whitespace character, but no more than 20 characters. All characters except single and double quotation marks are permitted. This step is required.

b. In the **Lookup Source** list, you can select or enter the source of the terminology lookup. SAS Clinical Data Integration does not validate whether the source exists. The value must contain at least one non-whitespace character, but no more than 20 characters. All characters except single and double quotation marks are permitted. This step is required.

11. Click **Next**. The Reporting Options page appears.

Note: If the **Next** and **Finish** buttons are dimmed, then one or more of the values on this page are not valid. Review the criteria for each value, and make any applicable corrections.

12. Edit the values required for your customization.

Note: To enable the **Error Message** field for editing, select the **Direct Edit (Advanced)** check box.

a. Select the **Report All Violations** check box to specify that all violations for the compliance check should be reported every time the validation is run. If you clear this check box, then only the first violation is reported.

b. In the **Error Message** field, specify the text to write to the data set when a violation is detected. You can use substitution variables in this field. The text must contain at least one non-whitespace character, but no more than 500 characters. All characters except single and double quotation marks are permitted.

13. Click **Finish**.

Note: If the **Next** and **Finish** buttons are dimmed, then one or more of the values on this page are not valid. Review the criteria for each value, and make any applicable corrections.

### Change the Compliance Check Status

To change the status of a compliance check, complete the following steps:

1. To change the status of a compliance check to Draft, right-click on the compliance check, and select **Make Draft**.

   Note:
   - A compliance check must have a Draft status for you to edit it.
   - You can select one or more compliance checks. To select a range of compliance checks, click on the first compliance check in the range. While holding down the SHIFT key, click on the last compliance check in the range. To select multiple compliance checks individually, click on the first compliance check. While holding down the CTRL key, click on other compliance checks.

2. To change the status of a compliance check to Active, right-click on the compliance check, and select **Make Active**.

   Note: You can select one or more compliance checks.
Delete a Compliance Check
To delete a compliance check, right-click on the compliance check, and select Delete. A confirmation message is displayed. Click Yes to delete the compliance check from the table as well as from persistent storage for the data standard.

Note: You can select one or more compliance checks.

Analyzing Domain Use and Promoting a Custom Domain

Problem
You want to know which domains are used the most. And, if a custom domain is reused significantly, you want to promote that custom domain to be part of the data standard.

Solution
You can view standard domain and custom domain use in clinical components. Using this usage information, you can identify custom domains that are used enough to become part of the data standard. Typically, a custom domain is for single use. It is available only to the clinical component in which it is defined. When a custom domain becomes a standard domain (that is, the custom domain is promoted to become part of the data standard), it can be included in any clinical component.

Note: You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix A1, “Adding Users to the Clinical Administrator Group,” on page 63.

Tasks
To analyze domain use and promote a custom domain, complete the following steps:

1. In the Clinical Administration tree, expand Data Standards. Right-click on the data standard that you want to analyze, and select Analyze Model Usage. The Analyze Model Usage dialog box appears. The Clinical Components list box displays all of the studies that currently use the selected data standard.

2. In the Clinical Components list box, select one or more of the studies that you want to analyze in detail. Click Show Domain Details.
   You can filter which domains to display using the Show domains of type filter. If no domains match the filter criteria, then a message appears.

3. In the Domain Details list, a summary of the domains and domain columns appears. Each domain that is included in the clinical components that have been selected is displayed as a column in the list. To see the details of the domain, double-click on the folder to expand the rows. Blue boxes specify which columns are in each domain.
   If the domain columns are identical across multiple clinical components, then you see the frequency in parentheses after the domain name. For domain columns that differ across clinical components, you see that each domain is listed separately.
   To view with which clinical component a domain is associated, right-click on the column heading, and select Display Domain Paths.
4. Right-click on a custom domain column heading, and select **Promote**. A confirmation message appears.

5. Click **Yes**. A new standard domain is created from the custom domain.

6. To verify that a standard domain was created from the custom domain, complete the following steps:
   
   a. In the Clinical Administration tree, expand the selected data standard.

   b. Expand **Domain Templates**. The new standard domain should be located in this folder.
Chapter 3
Managing Clinical Components

About Clinical Component Management

SAS Clinical Data Integration clinical components are the top-level containers for all of the content and metadata created during the course of an entire study. SAS Clinical Data Integration enables you to manage the following two types of clinical components:
• a study, such as study-level metadata and content
• a submission, such as aggregated metadata and content, or a collection of studies

In SAS Clinical Data Integration, a trial manager can centrally define and manage study definitions, set up default content, and monitor the progress of the domain mapping process.

Before you create a clinical component, you can define the defaults for the clinical component. You can use default folders to maintain consistent metadata organization in a clinical component when it is created. You can use default libraries to maintain consistent use of SAS librefs. This consistency is necessary when you have standard programs and macros that are dependent on consistent SAS librefs.

For each clinical component, you can define one or more default data standards. When defining a data standard, remember that you are affecting the available data standard selections in all SAS Clinical Data Integration wizards within that clinical component. Only the data standards that you define as the defaults are displayed. These default settings ensure that you are always using the correct version of a data standard for a study or submission. After you use the New Clinical Component wizard to create a clinical component, default content is created automatically in the new clinical component.

Because all activities and relationships are stored in metadata, SAS Clinical Data Integration can produce a summary of the statuses of all activities for a selected study or submission. If you have multiple programmers working on the same submission or study, you can easily see what domains have been created, what domains are used in a mapping process, and whether a validation transformation is using a certain domain. If you are using change management, you can view who is working on the submission or study. For more information about change management, see SAS Data Integration Studio: User’s Guide.

Typical user tasks include the following:
• working with default folders and libraries
• creating and defining a clinical component
• monitoring the statuses of domains
• refreshing a standard domain

---

**Working with Default Folders**

**Problem**

You want to create a metadata folder structure that enables consistency of content between studies or submissions.

**Solution**

SAS Clinical Data Integration enables you to define a metadata folder structure using default folders. This folder structure maintains consistent metadata organization in a clinical component when the clinical component is created.

You can customize which default folders are applied to all new studies or submissions. You can modify the default folder properties.

*Note:* You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix A1, “Adding Users to the Clinical Administrator Group,” on page 63.
**Tasks**

**Add a Default Folder**
To add a folder to the default folder structure for a specific clinical component type, complete the following steps:

1. In the Clinical Administration tree, expand the Clinical Components folder. Expand the clinical component type to which you want to add a default folder.
2. Expand Default Content. Right-click on Root Folder, and select New Subfolder. A new, untitled subfolder is created and displayed.
   
   *Note:* You can create a subfolder in any default folder.
3. Type a name for the subfolder, and then press ENTER.
   
   *Note:* A subfolder name must meet the following criteria:
   - The name cannot be more than 60 characters.
   - The name is not the same as any existing default folder name in the same parent folder. The comparison check is not case sensitive.
   - The name does not include whitespace characters.

**View and Modify Default Folder Properties**
To view and modify default folder properties, complete the following steps:

1. In the Clinical Administration tree, expand the Clinical Components folder. Expand the clinical component type that includes the default folder.
2. Expand Default Content, and then expand Root Folder. The available default folders appear. Default folders can have subfolders. You can expand any default folder to view its subfolders.
3. Right-click on the default folder that you want to modify, and select Properties. The Default Folder Properties window appears.
4. In the Name field, edit the name of the folder.
   
   *Note:* A folder name must meet the following criteria:
   - The name cannot be more than 60 characters.
   - The name is not the same as any existing default folder name in the same parent folder. The comparison check is not case sensitive.
   - The name does not include whitespace characters.
5. In the Description field, edit the description.
   
   *Note:* A description cannot be more than 200 characters.
6. Click OK to save the changes. Click Cancel to exit the window without saving changes.

**Delete a Default Folder**
To delete a default folder, complete the following steps:

1. In the Clinical Administration tree, expand the Clinical Components folder. Expand the clinical component type from which you want to delete a default folder.
2. Expand Default Content, and then expand Root Folder.
3. Right-click on the default folder that you want to delete, and select **Delete**. The folder and any subfolders in that folder are deleted and no longer displayed.

---

**Working with Default Libraries**

**Problem**

You want to define default libraries to use in a study or submission to maintain consistent use of SAS librefs.

**Solution**

SAS Clinical Data Integration enables you to define libraries to use in studies or submissions. It also enables you to edit the library properties. This consistency is necessary when you have standard programs and macros that are dependent on consistent SAS librefs.

*Note:* You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix A1, “Adding Users to the Clinical Administrator Group,” on page 63.

**Tasks**

**Add a Default Library**

To add a library as a default library for a specific clinical component type, complete the following steps:

1. In the Clinical Administration tree, expand the **Clinical Components** folder. Expand the clinical component type to which you want to add a default library.

2. Expand **Default Content**. Right-click on **Libraries**, and select **New Default Library**. The New Default Library wizard opens. The Default Library Information page appears.

3. In the **Name** field, enter a name for the library.

   *Note:* A library name must meet the following criteria:

   - The name cannot be more than 60 characters.
   - The name is not the same as any existing default library name in the clinical component. The comparison check is not case sensitive.

4. In the **Libref** field, enter the name of the libref.

   *Note:* A libref name must meet the following criteria:

   - The name cannot be more than 8 characters.
   - The name is not the same as any existing default library name in the clinical component. The comparison check is not case sensitive.
   - The first character must be an alphabetic character or an underscore.
   - Each subsequent character must be an alphabetic character, integer, or an underscore.
5. In the **Description** field, enter a description of the library. This step is optional.
   
   **Note:** A description cannot be more than 200 characters.

6. Click **Finish**. The new default library is displayed in the Libraries folder.

### View and Modify Default Library Properties

To view and modify default library properties, complete the following steps:

1. In the Clinical Administration tree, expand the **Clinical Components** folder. Expand the clinical component type that includes the default library.

2. Expand **Default Content**, and then expand **Libraries**. The available default libraries are displayed.

3. Right-click on the default library that you want to modify, and select **Properties**. The Default Library Properties window is displayed.

4. In the **Name** field, edit the name of the library.
   
   **Note:** A library name must meet the following criteria:
   - The name cannot be more than 60 characters.
   - The name is not the same as any existing default library name in the clinical component. The comparison check is not case sensitive.

5. In the **Libref** field, edit the name of the libref.
   
   **Note:** A libref name must meet the following criteria:
   - The name cannot be more than 8 characters.
   - The name is not the same as any existing default library name in the clinical component. The comparison check is not case sensitive.
   - The first character must be an alphabetic character or an underscore.
   - Each subsequent character must be an alphabetic character, integer, or an underscore.

6. In the **Description** field, edit the description of the library.
   
   **Note:** A description cannot be more than 200 characters.

7. Click **OK** to save the changes. Click **Cancel** to exit the window without saving changes.

### Delete a Default Library

To delete a default library, complete the following steps:

1. In the Clinical Administration tree, expand the **Clinical Components** folder. Expand the clinical component type from which you want to delete a default library.

2. Expand **Default Content**, and then expand **Libraries**.

3. Right-click on the default library that you want to delete, and select **Delete**. The library is deleted and no longer displayed.
   
   **Note:** You can delete more than one library at a time. To select multiple libraries to delete, click on the first library. While holding down the CTRL key, click on other libraries, and then select **Delete**.
Creating and Defining a Clinical Component

Problem

You want to create a study or submission.

Solution

Studies and submissions are created using the New Clinical Component wizard. The wizard collects basic object metadata such as name, description, and content location in the metadata tree. Then, the wizard collects metadata about the clinical component. For example, a study collects metadata such as protocol title, indication, and phase. After metadata is collected, the versions of the data standards that can be used for the clinical component are defined.

Note: Only an administrator can set the default content for a clinical component using the Clinical Administration tree. For more information, see Appendix A1, “Adding Users to the Clinical Administrator Group,” on page 63.

Tasks

To create and define a clinical component, complete the following steps:

1. In the Folders tree, right-click on a folder, and select New Clinical Component. The New Clinical Component wizard opens. The General Information page appears.

2. In the Name field, enter a name for the clinical component. The name cannot be more than 60 characters in length. Click Next.

   The Clinical Component Type Selection page appears.

3. In the Description field, enter a description of the clinical component. The description cannot be more than 200 characters.

4. By default, the Location field is set to the folder in which you opened the New Clinical Component wizard. If you want to change the location of the clinical component, then click Browse, and then select a new location. The new location must not be an existing clinical component root folder or a subfolder of an existing clinical component root folder.

   When the New Clinical Component wizard is opened, the Location field will default to your home folder My Folder if any of the following is true:
   - No folder is selected.
   - More than one folder is selected.
   - An object is selected that is not a folder.

5. Click Next.

   The Clinical Component Type Selection page appears.

6. Select a clinical component type from the list.

   Note: The default selection is Study.
7. Click Next.
   The Data Standards Selection page appears.
8. Select the data standards to apply to the clinical component. All active data standards to which you have access are displayed. You can select numerous data standards, or you can select none.
9. Click Next.
   The Clinical Component Properties page appears.
10. Set the values for the properties of the clinical component type. The properties that are available on this page and their default values are predetermined by the administrator’s configuration of the data standard’s property model.
   Note: Do not use special characters in the properties fields. Special characters include single quotation marks, double quotations marks, and hyphens.
11. Click Next.
   The Library Selection page appears.
12. Select one or more libraries to associate with the clinical component.
   The libraries that are available on this page are predetermined by the default content for the type of clinical component that is being created.
   Note: You do not have to select a library to create a clinical component.
13. Click Next.
   The Controlled Terminology page appears.
14. To select a controlled terminology package to associate with the clinical component, click Add. The Available Terminology Packages window appears. The controlled terminology packages that are available, as predetermined by the administrator, are listed. Select a package, and click OK.
   Note: If no controlled terminology packages are available, then a message is displayed.
   To remove a selected controlled terminology package, click Remove. Then, click OK to confirm.
   You do not have to associate a controlled terminology package with a clinical component.
15. Perform one of the following:
   • If you are creating a clinical component, then click Finish.
   • If you are creating a submission, then go to step 16 on page 29.
16. In the Contributing Studies page, select the study or studies to associate with the submission. All studies to which you have access are displayed. You can select numerous studies, or you can select none. Click Finish.
You can modify the properties of an existing clinical component from the Clinical Administration tree.

*Note:* You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix A1, “Adding Users to the Clinical Administrator Group,” on page 63.

**Tasks**

To modify the properties of an existing clinical component, complete the following steps:

1. In the Clinical Administration tree, expand the **Clinical Components** folder. Expand the clinical component type that you want to edit.
2. Expand the **Instances** folder.
3. Right-click on the study or submission that you want to modify, and select **Properties**. The properties dialog box for that clinical component appears.
4. Select the tab that contains the information that you want to edit. For example, if you want to modify the data standards associated with a study, then click the **Standards** tab.
5. Make your changes. Click **OK** to save the changes. Click **Cancel** to exit without making changes.

---

### Deleting a Clinical Component

**Problem**

You want to delete an existing study or submission.

**Solution**

You can delete an existing clinical component from the Clinical Administration tree.

*Note:* You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix A1, “Adding Users to the Clinical Administrator Group,” on page 63.

**Tasks**

To delete an existing clinical component, complete the following steps:

1. In the Clinical Administration tree, expand the **Clinical Components** folder. Expand the clinical component type that you want to delete.
2. Expand the **Instances** folder.
3. Right-click on the study or submission that you want to delete, and select **Delete**.
4. Click **OK** to confirm the deletion.

   *Note:* The clinical component is deleted, but the associated folder and its contents are not. To delete the contents of the associated folder, view the Folders tree. Right-click on the folder that you want to delete, and click **Delete**. You cannot delete a folder if you do not have the correct permissions to delete it.

   The reverse is also true. You cannot delete the root folder of a clinical component in the Folders tree unless you have first deleted the clinical component from the Clinical Administration tree.

---

**Monitoring the Statuses of Domains**

**Problem**

You want a progress report about the statuses of the domains for your study or submission.

**Solution**

You can monitor the statuses of domains to determine the progress of mapping the source data. In addition, you can determine whether a domain has been validated for compliance with a data standard.

*Note:* You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix A1, “Adding Users to the Clinical Administrator Group,” on page 63.

**Tasks**

To monitor the progress of a clinical component, complete the following steps:

1. In the Clinical Administration tree, expand the **Clinical Components** folder. Expand the clinical component type that you want to monitor.

2. Expand the **Instances** folder.

3. Right-click on the study or submission that you want to monitor, and select **Monitor Domain Status**. The Domain Status dialog box for that clinical component appears.

4. In the Domain Status dialog box, the **Domains** table reports the following information:
   
   - the name of the domain
   - the ID of the domain
   - the description of the domain
   - whether the domain has mapping jobs defined (that is, the domain has a job where the domain is a target)
   - whether the domain has compliance jobs defined (that is, the domain is selected to be validated)
   - whether the domain is locked and by whom
Refreshing a Standard Domain

Problem

You want to compare and possibly refresh a modified standard domain. The standard domain is compared with the standard domain template from which it was created.

Solution

You can refresh the metadata of the standard domain using the metadata of the standard domain template from which it was created.

Note: You must have appropriate permissions to view the Clinical Administration tree. For more information, see Appendix A1, “Adding Users to the Clinical Administrator Group,” on page 63.

Tasks

To refresh the metadata of a selected standard domain, complete the following steps:

1. In the Folders tree, expand the folder, expand the clinical component, and expand any subfolders until you locate the standard domain that you are interested in refreshing.

2. Right-click on the standard domain, and select Refresh Domain.

   • If the standard domain template from which the domain was created and the standard domain do not differ, a message is displayed. Click Yes to view the domain-level properties and columns for the standard domain template and the domain. Click No to continue without viewing this information.

   • If the standard domain template from which the domain was created and the standard domain differ, the Refresh Domain window immediately appears. Differences between the standard domain template and the domain are displayed. If the standard domain was not based on a standard domain template, a warning message is displayed. Click OK to close the window. Because the standard domain was not based on a standard domain template, it cannot be refreshed.

3. In the Refresh Domain window, expand the nodes in either tree to view the differences.

4. In the Standard Domain Template tree, select the check box next to the item that you want refreshed in the domain.

   Remember the following considerations when selecting check boxes:

   • If you select a column to be refreshed, all of its properties are refreshed. A selected check box with a white background indicates that the Columns node and all of its child nodes are selected.

   • To refresh some properties of a column, expand the Columns node, and then select the check boxes for each property that you want to refresh. A selected check box with a gray background indicates that only some child nodes are selected.

   • To update the standard domain metadata to match the standard domain template metadata, select the root node check box in the Standard Domain Template tree.
5. Click **Apply Checked** to apply all of your selections. If there are no remaining differences to apply, or if you chose to update the standard domain metadata to match the standard domain template metadata, then the Refresh Domain window changes to view-only mode. Click **Close** to close the window.
Chapter 4
Working with Domain Data and Metadata

About Domain Data and Metadata ................................................................. 36
Create a Domain .................................................................................. 36
Create a Custom Domain .................................................................. 37
Duplicate a Domain (Copy from an Existing Domain) ....................... 37

Creating a Standard Domain ................................................................. 37
Problem ................................................................................................. 37
Solution ................................................................................................. 37
Tasks ....................................................................................................... 37

Creating a Custom Domain ................................................................. 38
Problem ................................................................................................. 38
Solution ................................................................................................. 39
Tasks ....................................................................................................... 39

Creating a Custom Domain from an Existing Domain ....................... 40
Problem ................................................................................................. 40
Solution ................................................................................................. 40
Tasks ....................................................................................................... 40

Editing Domain Properties ................................................................. 42
Problem ................................................................................................. 42
Solution ................................................................................................. 42
Tasks ....................................................................................................... 42

Editing Domain Column Properties ..................................................... 43
Problem ................................................................................................. 43
Solution ................................................................................................. 43
Tasks ....................................................................................................... 43

Add a Column to a Domain ................................................................. 43
Problem ................................................................................................. 43
Solution ................................................................................................. 43
Tasks ....................................................................................................... 44

Loading Data into Domains ................................................................. 44
Problem ................................................................................................. 44
Solution ................................................................................................. 44

Assessing CDISC SDTM Compliance ..................................................... 45
Problem ................................................................................................. 45
Solution ................................................................................................. 45
Tasks ....................................................................................................... 45

Reporting on CDISC SDTM Compliance ............................................... 46
Problem ................................................................................................. 46
Create a Domain

After a clinical component has been created, you can create domains within that clinical component. A data standard defines the domain template that is used to create the domain. You can use as many domain templates as you want or need. The domain templates that you use to create domains are copied into a folder. Associations in the domain template metadata bind the domain template copy in this folder to the data standard from which it was originated. These associations enable you to customize the domain template copy without affecting the data standard. In addition, these associations enable you to validate the copy to determine whether any customizations in the copy break the conformance to the data standard.

After selecting the domain templates that you want to use, you can assign a library. The library is where the physical data is created when the job is run.

About Domain Data and Metadata
Create a Custom Domain

During a study, there might not be an appropriate domain template for the domain that you want to create. In this case, you can create a custom domain.

Instead of basing a custom domain on an existing domain template, you can choose to base it on the underlying data standard. For example, SDTM defines a data model that is based on creating domains from groups of columns, specifically identifiers, interventions, events, findings, and timings. SAS Clinical Data Integration generalizes the concept of grouping columns with the term column group. A column group makes up a portion of a complete table. If a data standard does not have column groups, then creating a custom domain is not possible.

The key criterion for creating a custom domain is whether it is meant to hold intervention, event, or findings data. In SAS Clinical Data Integration, interventions, events, or findings are considered a conditional column group. From all conditional column groups, you can select only one per custom domain. In addition to selecting a conditional column group, you must specify identifiers and timing.

Next, you select the individual columns that you want to include in the custom domain. Some column names must be prefixed with the identifier. If you select a column that has this requirement, SAS Clinical Data Integration automatically creates the correct column name with the prefix. The New Custom Domain wizard enables you to define keys and set the column order before the domain is created.

Duplicate a Domain (Copy from an Existing Domain)

If you have a domain that almost meets your needs, then you can create a new domain using the existing domain as a template.

Creating a Standard Domain

Problem

You want to create a domain for a study using one of the standard domain templates.

Solution

SAS Clinical Data Integration provides domain templates that conform to existing data standards. You can create a new domain using the New Standard Domain(s) wizard. The domain name, identifier, description, and other properties cannot be edited in the wizard. The new domain that you create is an exact copy from a domain template that conforms to an existing data standard.

Tasks

To create a domain using a standard domain template, complete the following steps:
1. In the Folders tree, right-click on the clinical component folder in which you want to create the domain, and select **New ⇒ Standard Domain(s)**. The New Standard Domain(s) wizard opens. The Domain Location page appears.

2. By default, the **Location** field is set to the folder in which you initiated the action. If you want to change the default location of the domain, then click **Browse** to select a new location.

   *Note:* A domain can be created only in a folder that is a clinical component root folder, or in a subfolder of a clinical component root folder. The name of the clinical component that is associated with the domain location is displayed in the **Clinical Component** field. If the domain location does not contain the clinical component, then the **Clinical Component** field is empty. You must select a valid domain location before you can proceed in the wizard.

   Click **Next**. The Data Standard Selection page appears.

3. Select a data standard from the list of standards. The data standards in this list are associated with the clinical component in which the domain is to be created.

   All domains within a folder must be associated with the same data standard. If you want to create a copy of the domain using a different version of the data standard, then you must create the copy in a different folder. If a domain already exists in the target folder, and that domain is associated with a different data standard than what you just specified in the wizard, then a warning message is displayed. You must choose a valid data standard before you can proceed.

   Click **Next**. The Domain Template Selection page appears.

4. Select one or more domain templates to use when creating the domain.

   If a domain already exists in the target folder with the same ID or with the same name as a selected domain template, then a warning message is displayed. You must specify a valid name or ID before you can proceed.

   Click **Next**. The Library Selection page appears.

5. Select a library to assign to the domain. The library can be any library in the clinical component. If no libraries exist within the clinical component root folder or within a subfolder of the clinical component root folder, then a message is displayed.

   *Note:* You can create a domain without assigning a library. Later, you can create a library and assign it to the domain. However, if you use the domain in a job without first assigning a library, then the job fails. The job generates errors that indicate you must assign a library. If you attempt to open the domain to view the contents and records, then the open fails, and an error message is displayed.

6. Click **Finish** to create the new domain.

---

**Creating a Custom Domain**

**Problem**

You need to create a domain for a study, but there is not a standard domain template that meets your needs.
**Solution**

You can create a new custom domain inside a clinical component. The new domain uses the data model defined by the data standard to create the appropriate columns and metadata.

**Tasks**

To create a custom domain, complete the following steps:

1. In the Folders tree, right-click on the clinical component folder in which you want to create the custom domain, and select **New Custom Domain**. The New Custom Domain wizard opens. The Domain Location page appears.

2. By default, the **Location** field is set to the folder in which you initiated the action. If you want to change the default location of the domain, click **Browse** to select a new location.

   *Note:* A domain can be created only in a folder that is a clinical component root folder, or in a subfolder of a clinical component root folder. The name of the clinical component that is associated with the domain location is displayed in the **Clinical Component** field. If the domain location does not contain the clinical component, then the **Clinical Component** field is empty. You must select a valid domain location before you can proceed in the wizard.

   Click **Next**. The Data Standard Selection page appears.

3. Select a data standard from the list of standards. The data standards in this list are associated with the clinical component in which the domain is to be created.

   All domains in a folder must be associated with the same data standard. If you want to create a copy of the domain using a different version of the data standard, then you must create the copy in a different folder. If a domain already exists in the target folder, and that domain is associated with a different data standard than what you just specified in the wizard, then a warning message is displayed. You must choose a valid data standard before you can proceed.

   Click **Next**. The General Information page appears.

4. In the **Name** field, enter a name for the new domain. In the **Identifier** field, enter an identifier for the domain.

   *Note:* The name and identifier cannot be the same as the name or identifier of a domain template in the data model. When you click **Next**, the wizard validates the name and identifier. A warning message is displayed if either the name or identifier fails the validation.

   Click **Next**. The Domain Information page appears.

5. Enter the property values for the new domain.

   Click **Next**. The Library Selection page appears.

6. Select a library to assign to the domain. The library can be any library in the clinical component. If no libraries exist within the clinical component root folder or within a subfolder of the clinical component root folder, a message is displayed.

   *Note:* You can create a domain without assigning a library. Later, you can create a library and assign it to the domain. However, if you use the domain in a job without first assigning a library, the job fails. The job generates errors that indicate you must assign a library. If you attempt to open the domain to view the contents and records, then the open fails, and an error message is displayed.
Click Next. The Column Group Selection page appears.

7. Select a conditional column group to use in the new domain. Column groups are groups of columns that are available to all new domains in a data standard. This page displays the core column groups that are available to all new domains in the data standard.

    **Note:** Column groups can differ depending on the selected data model.

Click Next. The Column Selection page appears.

8. Select the individual columns that you want to include in the new domain. Click Add. The Available Columns list displays all of the core column groups and the selected conditional column group. You can add columns individually or as a group. To remove a column from the Selected Columns list, select the column or group of columns, and click Remove.

If you want to customize column properties, click Next. The Column Elaboration page appears. Otherwise, go to step 10.

9. Edit the properties for selected columns. The Selected Columns table displays all of the selected columns and their properties. Not all properties can be edited. Editable properties vary by data model.

You can change the column order. Select a column, and then click Move Up or Move Down to adjust its order.

If two or more columns are keys, you can change the key order. Click Order Keys. The Order Domain Keys window appears. Select a key, and then click Move Up or Move Down to adjust its order. Click OK to save the key order.

10. Click Finish to create the new domain.

---

**Creating a Custom Domain from an Existing Domain**

**Problem**

You need to create a domain for a study, but there is not a standard domain template that meets your needs. However, there is a domain in another study that meets your needs.

**Solution**

You can create a new custom domain using an existing domain.

**CAUTION:**

Use this process of creating a custom domain instead of using the standard SAS Data Integration Studio copy and paste actions. The copy and paste actions do not copy important domain metadata.

**Tasks**

To create a custom domain using an existing domain, complete the following steps:

1. In the Folders tree, right-click on the clinical component folder in which you want to create the custom domain, and select New ⇒ Custom Domain From Existing. The
New Custom Domain From Existing Domain wizard opens. The Domain Location page appears.

2. By default, the **Location** field is set to the folder in which you initiated the action. If you want to change the default location of the domain, click **Browse** to select a new location.

   *Note:* A domain can be created only in a folder that is a clinical component root folder, or in a subfolder of a clinical component root folder. The name of the clinical component that is associated with the domain location is displayed in the **Clinical Component** field. If the domain location does not contain the clinical component, then the **Clinical Component** field is empty. You must select a valid domain location before you can proceed in the wizard.

   Click **Next**. The Data Standard Selection page appears.

3. Select a data standard from the list of standards. The data standards in this list are associated with the clinical component in which the domain is to be created.

   All domains in a folder must be associated with the same data standard. If you want to create a copy of the domain using a different version of the data standard, then you must create the copy in a different folder. If a domain already exists in the target folder, and that domain is associated with a different data standard than what you just specified in the wizard, then a warning message is displayed. You must choose a valid data standard before you can proceed.

   Click **Next**. The Domain Selection page appears.

4. The **Available Domains by Clinical Component** list displays the clinical components and their domains for the selected data standard. Expanding a clinical component node displays all of the domains in the clinical component. Both standard and custom domains can be selected. You can select only one domain.

   Click **Next**. The General Information page appears.

5. The default values on this page are determined by the domain that you selected. You can edit the name and identifier for the new domain.

   *Note:* The name and identifier cannot be the same as the name or identifier of a domain template in the data model. When you click **Next**, the wizard validates the name and identifier. A warning message is displayed if either the name or identifier fails the validation.

   Click **Next**. The Domain Information page appears.

6. The default values on this page are determined by the domain that you selected. You can edit the property values for the new domain.

   Click **Next**. The Library Selection page appears.

7. Select a library to assign to the domain. The library can be any library in the clinical component. If no libraries exist within the clinical component root folder or within a subfolder of the clinical component root folder, then a message is displayed.

   *Note:* You can create a domain without assigning a library. Later, you can create a library and assign it to the domain. However, if you use the domain in a job without first assigning a library, the job fails. The job generates errors that indicate you must assign a library. If you attempt to open the domain to view the contents and records, the open fails, and an error message is displayed.

   Click **Next**. The Column Elaboration page appears.
8. Edit the properties for selected columns. The Selected Columns table displays all of the selected columns and their properties. Not all properties can be edited. Editable properties vary by data model.

You can change the column order. Select a column, and then click **Move Up** or **Move Down** to adjust its order.

If two or more columns are keys, you can change the key order. Click **Order Keys**. The Order Domain Keys window appears. Select a key, and then click **Move Up** or **Move Down** to adjust its order. Click **OK** to save the key order.

9. Click **Finish** to create the new domain.

---

**Editing Domain Properties**

**Problem**

You want to edit the properties of a domain.

**Solution**

Use the Properties dialog box.

**Tasks**

To edit domain properties, complete the following steps:

1. In the Folders tree, right-click on a domain, and select **Properties**. The Properties dialog box appears.

   *Note:* Property values cannot contain double quotation marks.

2. Click the **General** tab to edit the domain name and description.

3. Click the **Columns** tab to edit the columns in the domain.

4. Click the **Indexes** tab to edit the columns used as indexes.

5. Click the **Keys** tab to edit keys.

6. Click the **Physical Storage** tab to change the physical name.

7. Click the **Notes** tab to add general information about your domain.

8. Click the **Extended Attributes** tab to add metadata properties for the domain. This step is optional.

9. Click the **Clinical Domain** tab to change properties for your domain. The **Properties** table enables you to enter text and select values from lists depending on the property definition.

   *Note:* You might not be able to edit some property values.

   *Note:* Make sure that the Archive Title clinical domain property has a value so that it is displayed in the define.xml file. For more information about updating properties, see “Editing Domain Properties” on page 42.

10. Click **OK** to save the changes and exit the Properties dialog box.
Editing Domain Column Properties

Problem
You want to edit the properties of a domain column.

Solution
Use the column properties dialog box.

Tasks
To edit domain column properties, complete the following steps:
1. In the Folders tree, right-click on a domain, and select Properties. The Properties dialog box appears.
2. Click the Columns tab. The domain columns are listed.
3. Right-click on a column, and select Properties. The column properties dialog box appears.
   Note: Property values cannot contain double quotation marks.
4. Click the Notes tab to add general information about your domain column.
5. Click the Extended Attributes tab to add metadata properties for the domain column. This step is optional.
6. Click the Clinical Column tab to change properties for your domain column. The Properties tables enables you to enter text and select values from lists depending on the property definition.
   Note: You might not be able to edit some property values.
7. Click OK to save the changes and exit the column properties dialog box.
8. Click OK to save the changes and exit the Properties dialog box.

Add a Column to a Domain

Problem
You want to create a column in a domain.

Solution
Use the column properties dialog box.
Tasks

To add a column to a domain, complete the following steps:

1. In the Folders tree, right-click on a domain, and select Properties. The Properties dialog box appears.
   
   Note: Property values cannot contain double quotation marks.

2. Click the Columns tab. The domain columns are listed.

3. Click the New Column icon. A new entry appears as the last row of the columns table.

4. Enter a name and description for the column. Edit the default column characteristics if necessary.

5. Right-click on the new column, and select Properties. The column properties dialog box appears.

6. Select the Notes tab to add general information about your domain column.

7. Select the Extended Attributes tab to add metadata properties for the domain column. This step is optional.

8. Select the Clinical Column tab to change properties for your domain column. The Properties table enables you to enter text and select values from lists depending on the property definition.
   
   Note: You might not be able to edit some property values.

9. Click OK to save the changes and exit the column properties dialog box.

10. Click OK to save the changes and exit the Properties dialog box.

Loading Data into Domains

Problem

You want to load your study data into domains. In other words, you want to convert your study data into CDISC SDTM target files.

Solution

Create a SAS Data Integration Studio job to populate each domain with data. Creating a job uses standard SAS Data Integration Studio functionality. It does not require any functionality from SAS Clinical Data Integration. For more information about creating a job, see the SAS Data Integration Studio: User's Guide.
Assessing CDISC SDTM Compliance

Problem

You want to validate a domain for compliance with the CDISC SDTM data standard.

Solution

Use the CDISC-SDTM Compliance transformation to assess the structural and content compliance with a data standard. You can assess an individual domain or a set of domains. The process assesses whether the selected domains comply with the data standard.

Note: For detailed information about creating a job with a transformation, see the SAS Data Integration Studio: User's Guide.

Tasks

To assess compliance, complete the following steps:

1. In SAS Data Integration Studio, create a new job. Select File ➔ New ➔ Job. An empty job diagram is displayed on the Diagram page.

2. In the Transformations tree, expand Clinical, select CDISC-SDTM Compliance, and drag and drop it onto the diagram. The Diagram page displays the CDISC-SDTM Compliance transformation and the Results and Metrics data sets.

Note: By default, the Results and Metrics data sets are written to a temporary work location. If you want to store this information permanently, right-click on each table, and select Properties. On the Physical Storage tab, select a SAS library for the Location field.

3. In the diagram, double-click on CDISC-SDTM Compliance. The CDISC-SDTM Compliance Properties dialog box appears.

Note: By default, the CDISC-SDTM Compliance Results data set is written to a temporary work location. If you want to store this information permanently, right-click on the Results data set, and select Properties. Change the location on the Physical Storage tab. For detailed information about the properties dialog box, see the SAS Data Integration Studio: User's Guide.

4. Click the Data Standard tab. All active SDTM data standards are displayed.

5. Select a data standard with which you want to check compliance. Then, click the Domains tab. The clinical components are displayed.

6. Expand a clinical component to view its domains. Select domains that you want to validate, or select the clinical component to select all of its domains.

Note: You can select domains from multiple clinical components.

7. Click the Checks tab. If no compliance checks are displayed, then click Add. The Add Compliance Check(s) dialog box appears with a list of all available compliance checks.

Note: If you imported the CDISC SDTM 3.1.2 data standard, then compliance checks for this data standard also appear in the Standard column in the Checks tab. The Standard column is displayed if you select Show details. A check that has the
value \texttt{CDISC-SDTM} applies to both the CDISC SDTM 3.1.1 and CDISC SDTM 3.1.2 standards. A check that has the value \texttt{CDISC-SDTM 3.1.2} applies to the CDISC SDTM 3.1.2 standard only.

8. To view more information, select \textit{Show details}. Detailed information about each compliance check is displayed. Select one or more compliance checks from the list. Click \textit{Add Selected}. A confirmation message is displayed. Click \textit{OK}.

\textit{Note:} You can select and add more than one compliance check. Select the first compliance check, and while holding down the CTRL key, select additional compliance checks.

\textit{Note:} Some check IDs are listed more than once. When you select \textit{Show details}, you can view information that makes the individual compliance check unique. For example, consider the check ID SDTM0001:

- In the first record, \textit{Source} is \textit{Janus} and \textit{Severity} is \textit{Note}. If the domain fails this compliance check, then the Results data set reports a note.

- In the second record, \textit{Source} is \textit{WebSDM} and \textit{Severity} is \textit{Warning}. If the domain fails this compliance check, then the Results data set reports a warning.

To be efficient, only choose a subset of the compliance checks. It is inefficient to run the same compliance checks multiple times if the only differences between the checks are severity and source.

9. Click \textit{OK} to close the CDISC-SDTM Compliance Properties dialog box. A green checkmark next to the CDISC-SDTM Compliance transformation indicates that the transformation is completed.

\textit{Note:} If you see a red X, then hover over the transformation and information about any errors will appear. A typical error is that selected domains do not have a library assigned. Correct any errors before running the job.

10. Click \textit{Run} to run the job. SAS Data Integration Studio generates the SAS code for validating the selected data standard model, and then submits the code to SAS. The Results and Metrics data sets are generated.

11. Review the Results data set to see the results of the compliance checks. You might want to connect the Results and Metrics data sets as input to the code that will be used to generate formatted reports of the results.

\textit{Note:} You might encounter errors or warnings in the SAS log during job execution. These errors or warnings do \textit{not} mean that validation was unsuccessful. Most errors that halt a validation are reported in the Results data set. As a general rule, the Results data set reports failures and provides information about the cause of the failures. For more information about validation, see the \textit{SAS Clinical Standards Toolkit: User Guide}.

---

\textbf{Reporting on CDISC SDTM Compliance}

\textit{Problem}

You want to run a report about the compliance of a single domain or multiple domains with the CDISC SDTM data standard. You can run a report on a domain, domains, or compliance checks.
**Solution**

Use the CDISC-SDTM Compliance transformation to run a report about the compliance of a single domain or multiple domains with a data standard. You can run a report on a domain, domains, or compliance checks.

*Note:* For detailed information about creating a job with a transformation, see the SAS Data Integration Studio: User’s Guide.

**Tasks**

To run a report, complete the following steps:

1. In SAS Data Integration Studio, create a new job. Select File ➔ New ➔ Job. An empty job diagram is displayed on the Diagram page.

2. In the Transformations tree, expand Clinical, select CDISC-SDTM Compliance, and drag and drop it onto the diagram. The Diagram page displays the CDISC-SDTM Compliance transformation and the Results and Metrics work tables.

3. In the diagram, double-click on CDISC-SDTM Compliance. The CDISC-SDTM Compliance Properties dialog box appears.

4. Click the Reports tab. The reports panel appears.

5. Select whether to Report by Domain or Report by Check.

6. Beside the Browse to Folder field, click Browse to select a folder in which to place the report. Or, in the Server Folder field, enter the name of a server folder. The folder must be on the server and must not be a local folder.

7. Enter a name for the report in the Report File Name field.

8. Specify whether the report output format is HTML, PDF, or RTF.

9. You can limit the number of records to include in the report by entering a number in the Limit # of records to field. If you leave this field blank, then all records are included in the report.

10. Select which panels to include in the report and whether informational messages are included.

11. Click OK to close the CDISC-SDTM Compliance Properties dialog box.

12. Click Run to run the job. To run the job, you must have selected a data standard, at least one domain, and at least one compliance check in the CDISC-SDTM Compliance transformation. SAS Data Integration Studio generates the SAS code for validating the selected data standard model, and then submits the code to SAS. The Results and Metrics work tables (data sets) and reports are generated.

13. Locate the report in the selected server folder and open it for review.
The CDISC-SDTM to CRT-DDS Transformation

Problem
You want to transform domains collected during a study. Specifically, you want to transform them from the CDISC SDTM standard format into the CRT-DDS standard format.

Solution
Use the CDISC-SDTM to CRT-DDS transformation to transform SDTM domains into a define.xml file. The define.xml file complies with the CRT-DDS standard.

Note: For detailed information about creating a job with a transformation, see the SAS Data Integration Studio: User's Guide.

Tasks
Before you can create a job that uses a define.xml file, you must register a new document file. The document file references the target define.xml file.

Note: The target define.xml file is created on the server. If you want to open the target define.xml file from the job, then the target file must be in a shared location that can be accessed from the computer on which you are using SAS Data Integration Studio. An example of a shared location is a network drive.

For more information about registering a new document file, see the SAS Data Integration Studio: User's Guide.

To transform SDTM domains into a define.xml file that complies with the CRT-DDS standard, complete the following steps:

1. In SAS Data Integration Studio, create a new job. Select File ➔ New ➔ Job. An empty job diagram is displayed on the Diagram page.

2. In the Transformations tree, expand Clinical, select CDISC-SDTM to CRT-DDS, and drag and drop it onto the diagram. The Diagram page displays the CDISC-SDTM to CRT-DDS transformation.

3. Right-click on CDISC-SDTM to CRT-DDS, and select Properties. The CDISC-SDTM to CRT-DDS Properties dialog box appears.

4. Click the Domains tab.

Note: Make sure that the Archive Title clinical domain property has a value so that it is displayed in the define.xml file. For more information about updating properties, see “Editing Domain Properties” on page 42.

5. In the Available Domains by Clinical Component list, select one or more domains to include in the define.xml file.

6. Click the Generation tab. This step is optional.

7. In the Header comment field, enter the header comment text for the define.xml file. This step is optional.

8. In the Output encoding field, select an encoding to use. This step is optional.
9. In the **Output Stylesheet** area, select a style sheet to use. This step is optional.
   
   *Note:* By default, no output style sheet is used. You can use a default style sheet provided by SAS Clinical Standards Toolkit, or you can select your own style sheet.

10. Click **OK**.

11. In the Folders tree, drag and drop the define.xml file onto the diagram.

12. Connect the CDISC-SDTM to CRT-DDS transformation to the define.xml file. Drag the cursor from the output port of the transformation to the define.xml file. This action connects the define.xml file to the transformation.

13. By default, the CRT-DDS Results data set is written to a temporary work location. If you want to store this information permanently, right-click on the Results data set, select **Properties.** Change the location on the **Physical Storage** tab. For detailed information about the properties dialog box, see the *SAS Data Integration Studio: User's Guide.*

14. Save and run the job. SAS Data Integration Studio generates the SAS code for transforming, and then submits the code to SAS. The CRT-DDS define.xml file is created. If a define.xml already exists in that location, then it is overwritten (if the permissions on the file allow it to be overwritten). The results are written to the CDISC-SDTM to CRT-DDS Results data set. Review the Results data set and check for errors or warnings.

   You can view the define.xml file by navigating to the location where you created the document file, and then open the define.xml file with a Web browser. If the Web browser fails to open the define.xml file, and displays an error message about an invalid path, then the define.xml file must be located on a drive to which you do not have access. To resolve the problem, move the define.xml file.

---

**Reporting on the CDISC-SDTM to CRT-DDS Transformation**

**Problem**

You want to run a report about the CDISC-SDTM to CRT-DDS transformation.

**Solution**

Use the CDISC-SDTM to CRT-DDS transformation to run a report about the transformation.

*Note:* For detailed information about creating a job with a transformation, see the *SAS Data Integration Studio: User's Guide.*

**Tasks**

To run a report, complete the following steps:

1. In SAS Data Integration Studio, create a new job. Select **File ➜ New ➜ Job.** An empty job diagram is displayed on the Diagram page.
2. In the Transformations tree, expand **Clinical**, select **CDISC-SDTM to CRT-DDS**, and drag and drop it onto the diagram.

3. In the diagram, double-click on **CDISC-SDTM to CRT-DDS**. The CDISC-SDTM to CRT-DDS Properties dialog box appears.

4. Click the **Reports** tab. The reports panel appears.

5. Select the **Generate Report** check box.

6. Beside the **Browse to Folder** field, click **Browse** to select a folder in which to place the report. Or, in the **Server Folder** field, enter the name of a server folder. The folder must be on the server and must not be a local folder.

7. Enter a name for the report in the **Report File Name** field.

8. Specify whether the report output format should be **HTML**, **PDF**, or **RTF**.

9. You can limit the number of records to include in the report by entering a number in the **Limit # of records to** field. If you leave this field blank, then all records are included in the report.

10. Select which panels to include in the report and whether informational messages are included.

11. Click **OK** to close the CDISC-SDTM to CRT-DDS Properties dialog box.

12. Click **Run** to run the job. To run the job, you must have selected a domain or domains in the CDISC-SDTM to CRT-DDS transformation. SAS Data Integration Studio generates the SAS code for transforming, and then submits the code to SAS.

13. Review the report.

---

**Working with Data from the CDISC-SDTM to CRT-DDS Transformation**

**Problem**

You want to save the data from the CDISC-SDTM to CRT-DDS transformation. Saving this data enables you to edit the tables to add information to the CRT-DDS that is not represented in CDI metadata. This section describes how to:

- save the data from a CDISC-SDTM to CRT-DDS transformation
- include computational algorithm and codelist metadata in the CRT-DDS define.xml file
- add annotated CRF and value-level metadata to the CRT-DDS define.xml file

**Save the Data from a CDISC-SDTM to CRT-DDS Transformation**

When creating a define.xml file, select a location into which tables that are created by the CDISC-SDTM to CRT-DDS transformation can be copied.

To save the data from a CDISC-SDTM to CRT-DDS transformation into a specified location, complete the following steps:
1. Add a CDISC-SDTM to CRT-DDS transformation to a job. For detailed information about adding a CDISC-SDTM to CRT-DDS transformation, see “The CDISC-SDTM to CRT-DDS Transformation” on page 48.

2. Right-click on **CDISC-SDTM to CRT-DDS**, and select **Properties**. The CDISC-SDTM to CRT-DDS Properties dialog box appears.

3. Click the **Generation** tab.

4. Select the **Save work tables to permanent location** check box. The **Browse** button next to the **Location** field becomes active, and **Location** field itself becomes active.

5. Click the **Browse** button. The Select Path dialog box appears.
   
   **Note:** The file type is **Folder**. You can select entries that are folders.

6. Select a folder in which you want to save the CRT-DDS tables. The folder that you select must be accessible by the SAS Workspace Server where the code executes. This means that the C:\ folder that is listed in the Select Path dialog box is not on your local PC, but is on the SAS Workspace Server. You must have write access to this folder. If there are tables from a previous CDISC-SDTM to CRT-DDS transformation in this folder, then they will be overwritten without any prompting.

7. Click **OK** in the Select Path dialog box. The **Location** field contains the folder that you selected in the Select Path dialog box.

8. Click **OK** in the CDISC-SDTM to CRT-DDS Properties dialog box.

9. Save and run the job. SAS Data Integration Studio generates the SAS code for validating, and then submits the code to SAS. The CRT-DDS define.xml file is created. Several data sets are created in the folder that you selected in the **Generation** tab. Depending on the metadata found for the domain and study, many of these data sets (tables) will be empty. For more information about the data sets (tables) that are created, see the *SAS Clinical Standard Toolkit: User's Guide*.

### Include Computational Algorithm and Codelist Metadata in the CRT-DDS define.xml File

**Problem**

You want to include computational algorithm and codelist metadata about the domains that you collected during a study. This study involved domains transformed from the CDISC-SDTM standard format to the CRT-DDS standard format. To do this, you need to edit the metadata properties for the domain columns, and then use the CDISC-SDTM to CRT-DDS transformation to transform CDISC SDTM domains into a define.xml file that meets the CRT-DDS standard.

**Solution**

For each domain column that has a codelist or computational algorithm, you need to edit the clinical properties.

**Tasks**

To edit clinical properties, complete the following steps:

1. In the Folders tree, right-click on a domain, and select **Properties**. The Properties dialog box appears.

2. Click the **Columns** tab. The domain columns are listed.
3. Right-click on a column, and select Properties. The column properties dialog box appears.

4. Click the Clinical Domain tab.

5. Edit the Method property to enter the computational algorithm metadata.

6. Edit the XML Codelist property to enter the codelist metadata.

7. Click OK to save the changes and exit the column properties dialog box.

8. Click OK to save the changes and exit the Properties dialog box.

9. Add a CDISC-SDTM to CRT-DDS transformation to a job. For detailed information about adding a CDISC-SDTM to CRT-DDS transformation, see “The CDISC-SDTM to CRT-DDS Transformation” on page 48. Select the domains of the columns that you edited in the previous steps.

10. Run the job. The computational algorithm and codelist metadata will be included in the CRT-DDS define.xml file.

11. Open the define.xml file. Notice that the Codelist and Computational Method information is displayed for each of the domain columns where you updated the column properties.

---

**Add Annotated CRF and Value-Level Metadata to the CRT-DDS define.xml File**

**Add Annotated CRF Metadata to the CRT-DDS define.xml File**

You want to include the annotated CRF metadata about the domains that you collected during a study. Edit the SAS tables that were generated by the CDISC-SDTM to CRT-DDS transformation to include the metadata. Run the %CRTDDS_WRITE macro to generate the CRT-DDS define.xml file.

To update the SAS tables and run the macro, complete the following steps:

1. Add a CDISC-SDTM to CRT-DDS transformation to a job. For detailed information about adding a CDISC-SDTM to CRT-DDS transformation, see “The CDISC-SDTM to CRT-DDS Transformation” on page 48.

2. Click the Generation tab. Select the Save work tables to permanent location check box, and enter a location for the generated SAS tables. For more information about saving tables, see “Save the Data from a CDISC-SDTM to CRT-DDS Transformation” on page 50.

3. Click Run to run the job. The define.xml file is generated, and the SAS tables used to generate this file are included.

4. Add records to the annotatedcrfs, mdvleaf, and mdvleaftitles tables.
   a. Drag and drop the User Written Code transformation onto the diagram.
   b. Right-click on User Written, and select Properties. The User Written Properties dialog box appears.
   c. Click the General tab, and rename the transformation Update SAS CRT-DDS tables.
   d. Click the Code tab. In the Code generation mode field, select All user written.
   e. In the code editor, add the code to include annotated CRF metadata. The following code example includes annotated CRF metadata:
*Lookup OID for the SDTM 3.1.2 standard in MetaDataVersion;
proc sql noprint;
select OID into :mdv from _svWork.MetaDataVersion
where name="CDISC-SDTM 3.1.2";
quit;
*Add records for Annotated CRF;
proc sql;
insert into _svWork.AnnotatedCRFs
set DocumentRef = "BlankCRF",
leafID= "AnnotatedCRF",
FK_MetaDataVersion = "mdv";
insert into _svWork.MDVLeaf
set ID= "AnnotatedCRF",
href = "/blankcrf.pdf",
FK_MetaDataVersion = "mdv";
insert into _svWork.MDVLeafTitles
set title= "Blank Annotated CRF",
FK_MDVLeaf = "AnnotatedCRF";
quit;
*reassign srcdata to location of _svWork data sets;
data _null_; path=pathname('_svwork'); rc=libname('srcdata');
rc=libname('srcdata',path);
run;
*create new define.xml file using updated SAS CRT-DDS data sets;
%crtdds_write(_cstCreateDisplayStyleSheet=1);
f. Click OK to save the code.
5. Click Run to run the job. Review the define.xml file and make sure that the annotated CRF metadata is included.

Add Value-Level Metadata to the CRT-DDS define.xml file
You want to include the value-level metadata about the domains that you collected during a study into the CRT-DDS standard format. Edit the SAS tables that were generated by the CDISC-SDTM to CRT-DDS transformation to include the metadata. Run the %CRTDDS_WRITE macro to generate the CRT-DDS define.xml file.

To update the SAS tables and run the macro, complete the following steps:

1. Add a CDISC-SDTM to CRT-DDS transformation to a job. For detailed information about adding a CDISC-SDTM to CRT-DDS transformation, see “The CDISC-SDTM to CRT-DDS Transformation” on page 48.

2. Click the Generation tab. Select the Save work tables to permanent location check box, and enter a location for the generated SAS tables. For more information about saving tables, see “Save the Data from a CDISC-SDTM to CRT-DDS Transformation” on page 50.

3. Click Run to run the job. The define.xml file is generated, and the SAS tables used to generate this file are included.

4. Add records to the valuelists, itemvaluelistrefs, valuelistitemrefs, and itemdefs tables.
   a. Drag and drop the User Written Code transformation onto the diagram.
   b. Right-click on User Written, and select Properties. The User Written Properties dialog box appears.
   c. Click the Code tab. In the Code generation mode field, select All user written.
d. In the code editor, add the code to include the value-level metadata. The following code provides an example of how to include the value-level metadata on the SC domain. This example includes two values: height without shoes and weight without shoes.

```
* Lookup OID for the SDTM 3.1.2 standard in MetaDataVersion;
proc sql noprint;
select OID into :mdv from _svWork.MetaDataVersion
where name="CDISC-SDTM 3.1.2";
quit;
* Lookup OID for the SCTEST column in ItemDefs;
proc sql noprint;
select OID into :srccol from _svWork.ItemDefs
where name='SCTEST';
quit;
* Add record for a new valuelist SCTESTVALS;
proc sql;
insert into _svWork.ValueLists
set OID= "SCTESTVALS",
FK_MetaDataVersion = "&mdv";
* Add record associating the value list SCTESTVALS to the OID for SCTEST ItemDefs record;
insert into _svWork.ItemValueListRefs
set ValueListOID= "SCTESTVALS",
FK_ItemDefs = "&srccol";
* Add records to the ItemDefs data set for each value in the SCTESTVAL value list;
insert into _svWork.ItemDefs
set OID= "VAL001",
Name = "SCTEST",
DataType = "text",
Length = 3,
SASFieldName = "SCTEST",
comment = "Height taken barefoot",
label="Height in inches",
FK_MetaDataVersion = "&mdv"
set OID= "VAL002",
Name = "SCTEST",
DataType = "text",
Length = 4,
SASFieldName = "SCTEST",
comment = "Weight without shoes",
label="Weight in pounds",
FK_MetaDataVersion = "&mdv";
* Add records associating the value list SCTESTVALS to rows in the ItemDefs data set;
insert into _svWork.ValueListItemRefs
set ItemOID= "VAL001",
OrderNumber=1,
Mandatory="Yes",
KeySequence=1,
FK_ValueLists = "SCTESTVALS"
set ItemOID= "VAL002",
OrderNumber=2,
Mandatory="Yes",
KeySequence=2,
FK_ValueLists = "SCTESTVALS";
quit;
```
*reassign srcdata to location of _svWork data sets;
data _null_; path=pathname('_svwork'); rc=libname('srcdata');rc=libname('srcdata',path);
run;
*create new define.xml file using updated SAS CRT-DDS data sets;
%crtdds_write(_cstCreateDisplayStyleSheet=1);

5. Click Run to run the job. The define.xml file is created in the location that was specified. It contains the value-level metadata for **Height** and **Weight** for the SCTEST column in the SC domain.

---

### Running the CDISC-SDTM to CRT-DDS Transformation on Saved Data

#### Problem

You want to run the CDISC-SDTM to CRT-DDS transformation on saved data so that the information that is stored in the data is added to the CRT-DDS standard.

#### Solution

You create and run a job with a transformation that creates a CRT-DDS define.xml file. The file includes SAS data sets that represent the CRT-DDS data standard model.

*Note:* For detailed information about creating a job with a transformation, see the *SAS Data Integration Studio: User's Guide*.

#### Tasks

To create a job with a transformation that creates a CRT-DDS define.xml file that includes the SAS data sets that represent the CRT-DDS data standard model, complete the following steps:

1. In SAS Data Integration Studio, create a new job. Select **File ⇒ New ⇒ Job**. An empty job diagram is displayed on the Diagram page.

2. Drag and drop the **User Written Code** transformation onto the diagram.

3. Right-click on **User Written**, and select **Properties**. The User Written Properties dialog box appears.

4. Click the **Code** tab. In the **Code generation mode** field, select **All user written**.

5. In the code editor, add the code to create the define.xml file. The following code example creates a define.xml file:

```sas
%let SASCrtddsTables = %nrquote(\myCDIServer\mydata\crtdds_tables);
%let DefPath = %nrquote(\myCDIServer\mydata\crtdds_tables);
%let DefFile = %nrquote(define.xml);
%
cst_setStandardProperties{
   _cstStandard=CDISC-CRTDDS
```
6. Modify the first two lines of the code to point to the location where your saved data sets exist, and where you would like to write out the resulting define.xml file.

7. Click **OK** to save the code.

8. Click **Run** to run the job.

9. From the Windows **Start** menu, select **Run**. Enter the location where your data sets exist (for example, `\myCDIServer\mydata\crtdds_tables`).

10. Open the define.xml file. The **Location** field contains a link to the corresponding transport file. If you click on the link, and the transport file does not exist, then you get an error. Search the file for “Blank Annotated CRF (blankCRF.pdf#page=3)”. The define file has valuelist values for **height** and **weight**.

---

**Validating a CRT-DDS define.xml File**

**Problem**

You want to validate a CRT-DDS define.xml file to ensure that it complies with the CRT-DDS data standard and that it meets XML standards.
Solution

Use the Validate CRT-DDS transformation to assess the validity of the define.xml file. Validity is based on the XML standards for CRT-DDS 1.0.0 as defined by CDISC.

Validity is based on the following:

- XML is well formed
- XML meets the XML schema specification

Note: For detailed information about creating a job with a transformation, see the SAS Data Integration Studio: User's Guide.

Tasks

Before you can create a job to validate a CRT-DDS define.xml file, you must register a new document file. The new document file must point to an existing define.xml file in a location that the SAS Workspace Server can access. For more information about registering a new document file, see the SAS Data Integration Studio: User's Guide.

To validate a CRT-DDS define.xml file, complete the following steps:

1. In SAS Data Integration Studio, create a new job. Select File ➔ New ➔ Job. An empty job diagram is displayed on the Diagram page.

2. In the Transformations tree, expand Clinical, select Validate CRT-DDS, and drag and drop it onto the diagram. The Diagram page displays the CRT-DDS transformation.

3. In the Folders tree, drag and drop the define.xml file onto the diagram.

4. Connect the define.xml file to the Validate CRT-DDS transformation. Drag the cursor from the define.xml file to the input port of the transformation. This action connects the define.xml file to the transformation.

5. By default, the CRT-DDS Validation Results data set is written to a temporary work location. If you want to store this information permanently, right-click on the Results data set, and select Properties. Change the location on the Physical Storage tab. For detailed information about the properties dialog box, see the SAS Data Integration Studio: User's Guide.

6. Click Run to run the job. SAS Data Integration Studio generates the SAS code for validating, and then submits the code to SAS. The CRT-DDS define.xml file is validated, and the results are written to the CRT-DDS Validation Results data set.

If there are errors in the CRT-DDS define.xml file, the CRT-DDS Validation Results data set provides a message for each error. An error message includes the line and column number in the define.xml file that generated the error.
Reporting on the Validity of a CRT-DDS define.xml File

Problem

You want to run a report about the validity of a CRT-DDS define.xml file.

Solution

Use the Validate CRT-DDS transformation to run a report about the validity of a CRT-DDS define.xml file.

Note: For detailed information about creating a job with a transformation, see the SAS Data Integration Studio: User's Guide.

Tasks

To run a report, complete the following steps:

1. In SAS Data Integration Studio, create a new job. Select File ⇒ New ⇒ Job. An empty job diagram is displayed on the Diagram page.
2. In the Transformations tree, expand Clinical, select Validate CRT-DDS, and drag and drop it onto the diagram.
3. In the diagram, double-click on Validate CRT-DDS. The Validate CRT-DDS Properties dialog box appears.
4. Click the Reports tab. The reports panel appears.
5. Select the Generate Report check box.
6. Beside the Browse to Folder field, click Browse to select a folder in which to place the report. Or, in the Server Folder field, enter the name of a server folder. The folder must be on the server and must not be a local folder.
7. Enter a name for the report in the Report File Name field.
8. Specify whether the report output format is HTML, PDF, or RTF.
9. You can limit the number of records to include in the report by entering a number in the Limit # of records to field. If you leave this field blank, then all records are included in the report.
10. Select which panels to include in the report and whether informational messages are included.
11. Click OK to close the Validate CRT-DDS Properties dialog box.
12. Click Run to run the job. SAS Data Integration Studio generates the SAS code for validating and then submits the code to SAS.
13. Review the report.
The Subject Sequence Generator Transformation

Overview

Some of the domains in the CDISC SDTM data standard model require a sequence number as an identifier variable (–SEQ). This sequence number ensures the uniqueness of records for each subject within a data set.

Problem

You want to load study data into the SDTM VS domain. In the study, each subject had a series of vital signs collected during each visit. (For example, on day 17, several readings were taken for heart rate and blood pressure). You need to uniquely identify each of these vital signs for each subject. This means that when you convert the study data, you need to populate each domain and populate the VSSEQ variable.

Solution

Use the Subject Sequence Generator transformation to generate a unique sequence number across subjects in a domain. After running the Subject Sequence Generator transformation, another variable is generated that enables you to uniquely identify each vital sign.

Note: For detailed information about creating a job with a transformation, see the SAS Data Integration Studio: User's Guide.

Task

To use the Subject Sequence Generator transformation, complete the following steps:

1. In SAS Data Integration Studio, create a new job. Select File ⇒ New ⇒ Job. An empty job diagram is displayed on the Diagram page.
2. In the Folders tree, drag and drop the source table for the domain onto the diagram.
3. In the Transformations tree, expand Clinical, select Subject Sequence Generator, and drag and drop it onto the diagram. The Diagram page displays the Subject Sequence Generator transformation.
4. Connect the source table to the Subject Sequence Generator transformation. Drag the cursor from the source table to the input port of the transformation. This action connects the source to the transformation.
5. Expand the Access folder, select Table Loader, and drag and drop it onto the diagram.
6. Connect the Subject Sequence Generator_OUTPUT table to the Table Loader. Drag the cursor from the output table to the input port of the Table Loader.
7. Connect the Table Loader to the SDTM VS domain (the data target). Drag the cursor from the output port of the Table Loader to the input port of the SDTM VS domain.
8. Right-click on Subject Sequence Generator, and select Properties. The Subject Sequence Generator Properties dialog box appears.
9. In the Folders tree, drag and drop the SDTM VS domain that you want to populate onto the diagram.
10. Click the **Options** tab.

11. In the **Update Source** field, select a setting. This step is optional.
   - **NO** indicates that the source table is not modified (that is, PROC SORT output is sent to a work table).
   - **YES** indicates that the source table is modified directly by PROC SORT in the code generation.

12. In the **Business Keys** list, adjust the order of the available keys. This list identifies the keys in the source table. A key makes a record unique. Use these keys to sort the data.

13. In the **Sequence Key Variable** list, select the name of the sequence variable in the target domain (–SEQ).

14. In the **Subject Variable** list, select a variable. The subject variable represents the unique subject identifier (USUBJID).

15. Click **OK**.

16. Save and run the job. SAS Data Integration Studio generates the SAS code for transforming, and then submits the code to SAS. The –SEQ variable is populated with a sequence number that is unique for each record for each subject.
Chapter 5
Working with Reports

About Reports

The reports feature in SAS Data Integration Studio can be used to generate SAS Clinical Data Integration reports. Clinical administrators can generate reports to show the following:

- basic study information that is defined in the metadata
- basic submission information that is defined in the metadata
- standards that are defined in the metadata
- controlled terminology packages

Running and Saving a Report

Problem

You want to run a report about basic study information that is defined in the metadata, basic submission information that is defined in the metadata, standards that are defined in the metadata, or controlled terminology packages.

Solution

Use the reports feature in SAS Data Integration Studio to run one of the four SAS Clinical Data Integration reports.

Note: For detailed information about opening the Reports dialog box and selecting options, see the SAS Data Integration Studio: User’s Guide.
Tasks

To run a SAS Clinical Data Integration report, complete the following steps:

1. In SAS Data Integration Studio, select Tools ➔ Reports. The Reports dialog box appears.

2. In the Show field, select Clinical.

3. Click on one of the SAS Clinical Data Integration reports so that it is highlighted.

4. Edit the name in the File Name field.

5. Make sure that the path in the Default Location field is where you want to save the report. You can enter a different location in the Default Location field. Or, you can click Browse to navigate to a different location. It is a good idea to use the Browse button to examine the file folder hierarchy and to check the path. The folder must be on the server and must not be a local folder.

6. Click the Run and view a report icon. Or, double-click on a report.

The report is run and saved to the location that is specified in the Default Location field.

The Report View dialog box appears after the report has been successfully created.

7. Click Yes to view the report, or click No to close the Report View dialog box. For more information about viewing a report, see the SAS Data Integration Studio: User's Guide.

Note: A report opens only if the Default Location field contains a valid path.
Appendix 1
Adding Users to the Clinical Administrator Group

Problem

Only users in the Clinical Administrators group have permission to see the Clinical Administration tree in SAS Data Integration Studio. Significant features and functions are available through the Clinical Administration tree.

The default security model for SAS Clinical Data Integration is described in the following table. Depending on the level of security required in your organization, users can modify security after installation. Contact your system administrator to determine how security is implemented in your organization.

Table A1.1 Default Users, Groups, Roles, and Descriptions

<table>
<thead>
<tr>
<th>User, Group, or Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Administrators</td>
<td>Default SAS Metadata Server administration group. This group should not be removed from any object in the metadata. Very few users should be added to this group.</td>
</tr>
<tr>
<td>Clinical Administrators</td>
<td>Members of this group can use the Clinical Administration tree and are responsible for managing data standards, clinical components, and controlled terminology.</td>
</tr>
<tr>
<td>SASUSERS</td>
<td>All authenticated users belong to this group. These users are responsible for defining content such as creating domains, jobs, and output. Users are assigned to this group by default.</td>
</tr>
</tbody>
</table>

Solution

Add a user to the Clinical Administrators group.

Tasks

To add a user to the Clinical Administrators group, complete the following steps:

1. Start SAS Management Console. Connect to the SAS Metadata Server as an unrestricted user. For more information, see SAS 9.2 Management Console: Guide to Users and Permissions.

2. On the Plug-ins tab, expand Environment Management, and select User Manager. The contents are displayed.

4. Click the Groups and Roles tab.

5. Select one or more users or groups to move to the Member of list.

6. Click OK to save the changes.
Appendix 2
Repairing Clinical Objects

Problem
You receive a message that one of the following clinical objects must be repaired:
• data standard
• domain template
• column group
• controlled terminology package
• clinical component
• domain or domain column

Solution
Use the Repair wizard to validate and repair clinical objects.

Note: It is not recommended that you export data standards or controlled terminology packages using Export ⇒ SAS Package or Export ⇒ Metadata in SAS Data Integration Studio. Instead, create the data standard or controlled terminology package using SAS Clinical Data Integration.

Tasks

Repair a Copy of a Data Standard
To repair a copy of a data standard, complete the following steps:
1. In the Folders tree or in the Clinical Administration tree, navigate to the data standard that you want to repair.
2. Right-click on the data standard, and select Repair Copy. The Repair Copy wizard appears. The Repair Copy Metadata page is displayed.
3. In the New Name field, accept the default name, or enter a new name. Click Next.
4. Review the summary, and click Finish. Repairs are made. The Folders tree or the Clinical Administration tree is updated with new information.

Repair a Domain Template
To repair a domain template, complete the following steps:
1. In the Folders tree or in the Clinical Administration tree, navigate to the data standard containing the domain template that you want to repair.

2. Right-click on the domain template, and select Repair. A message is displayed when the repair is completed.

3. If no problems are found, then click OK. If you want to review the analysis report, then click Details. Click Yes to repair the problems, or click No. If you choose to repair the problems, a progress indicator is displayed. A message is displayed when the repair is completed.

**Repair a Column Group**

To repair a column group, complete the following steps:

1. In the Folders tree or in the Clinical Administration tree, navigate to the data standard containing the column group that you want to repair.

2. Right-click on the column group, and select Repair. A message is displayed when the repair is completed.

3. If no problems are found, then click OK. If you want to review the analysis report, then click Details. Click Yes to repair the problems, or click No. If you choose to repair the problems, a progress indicator is displayed. A message is displayed when the repair is completed.

**Repair a Controlled Terminology Package**

To repair a controlled terminology package, complete the following steps:

1. In the Folders tree or in the Clinical Administration tree, navigate to the controlled terminology package that you want to repair.

2. Right-click on the controlled terminology package, and click Repair. A message is displayed when the repair is completed.

**Repair a Copy of a Clinical Component**

To repair a copy of a clinical component, complete the following steps:

1. In the Folders tree or in the Clinical Administration tree, navigate to the clinical component that you want to repair.

2. Right-click on the clinical component, and select Repair Copy. The Repair Copy wizard appears. The Repair Copy of Clinical Component page is displayed.

3. In the New Name field, accept the default name, or enter a new name. Click Next.

4. Review the summary, and click Finish. Repairs are made. The Folders tree or the Clinical Administration tree is updated with new information.

**Repair a Domain or Domain Column**

To repair a domain or domain column, complete the following steps:

1. In the Folders tree or in the Clinical Administration tree, navigate to the domain or the domain column that you want to repair.

2. Right-click on the domain or domain column, and select Repair Domain. A message is displayed when the repair is completed.

3. If no problems are found, then click OK. If you want to review the analysis report, then click Details. Click Yes to repair the problems, or click No. If you choose to repair the problems, a progress indicator is displayed. A message is displayed when the repair is completed.
The following icons are used in the SAS Data Integration Studio user interface. The icons indicate objects or transformations that are provided by SAS Clinical Data Integration.

<table>
<thead>
<tr>
<th>Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Clinical Data Integration</td>
<td><img src="image" alt="Clinical Data Integration Icon" /></td>
</tr>
<tr>
<td>Note: This icon overlays a standard graphic in SAS Data Integration Studio. This icon indicates that the object is a clinical object.</td>
<td></td>
</tr>
<tr>
<td>Clinical Component</td>
<td><img src="image" alt="Clinical Component Icon" /></td>
</tr>
<tr>
<td>Clinical Domain</td>
<td><img src="image" alt="Clinical Domain Icon" /></td>
</tr>
<tr>
<td>CDISC-SDTM to CRT-DDS Transformation</td>
<td><img src="image" alt="CDISC-SDTM to CRT-DDS Transformation Icon" /></td>
</tr>
<tr>
<td>CDISC-SDTM Compliance Transformation</td>
<td><img src="image" alt="CDISC-SDTM Compliance Transformation Icon" /></td>
</tr>
<tr>
<td>Validate CRT-DDS Transformation</td>
<td><img src="image" alt="Validate CRT-DDS Transformation Icon" /></td>
</tr>
</tbody>
</table>
A
annotated CRF metadata
adding to define.xml file 52

C
CDISC SDTM data standard
reporting on compliance 46
validating domains for compliance with 45
CDISC SDTM target files
converting study data into 44
CDISC-SDTM Compliance transformation 46
CDISC-SDTM to CRT-DDS transformation 48
including computational algorithm and codelist metadata in define.xml file 51
reporting on 49
running on saved data 55
saving data from 50
Clinical Administration tree permissions for 63
Clinical Administrators group
adding users to 63
clinical components 23
creating and defining 28
deleting 30
managing 23
modifying properties 29
repairing copies of 66
clinical domains
validating 12
clinical objects
repairing 65
clinical programmer and data manager 3
clinical properties
editing 51
codelist metadata
including in define.xml file 51
column groups 37
repairing 66
columns
adding to domains 43
editing domain column properties 43
repairing domain columns 66
common property model 9
compliance
assessing CDISC SDTM compliance 45
reporting on 46
compliance checks
changing the status of 19
creating customized 13
deleting 20
editing 16
managing 12
repairing on 46
status of 12
viewing 13
computational algorithm metadata
including in define.xml file 51
conditional column groups 37
controlled terminology 10
See also terminology packages
importing from SAS Clinical Standards Toolkit 11
controlled terminology packages
repairing 66
copying domains 37
CRT- DDS data standard
adding saved data to 55
CRT-DDS define.xml file
See define.xml file
CRT-DDS standard format
transforming CDISC-SDTM format to 48
custom domains
creating 37, 38
creating from existing domains 40
promoting 20
customizing
compliance checks 13
data standard domain templates 10
data standard properties 9

d data
loading into domains 44
data standards
assessing CDISC SDTM compliance 45
customizing domain templates 10
customizing properties 9
defining studies with 6
importing metadata 6
managing compliance checks 12
promoting custom domains to 20
repairing copies of 65
data standards administration 5
data standards administrator 2
default folders 24
adding 25
deleting 25
viewing and modifying properties 25
default libraries 26
adding 26
deleting 27
viewing and modifying properties 27
define.xml file 48
adding annotated CRF and value-level metadata to 52
adding value-level metadata to 53
including computational algorithm and
codelist metadata in 51
reporting on validity of 58
validating 56
domain columns
repairing 66
domain properties
editing 42
domain templates
creating domains and 36
creating standard domains 37
customizing, for data standards 10
repairing 65
domains
adding columns to 43
analyzing usage information 20
copying from an existing domain 37
creating 36
creating custom domains 37, 38
creating custom domains from existing
domains 40
creating from existing domains 37
creating standard domains 37
duplicating 37
editing column properties 43
editing properties 42
loading data into 44
monitoring status of 31
promoting custom domains 20
refreshing standard domains 32
repairing 66
reporting on compliance 46
transforming from CDISC SDTM
standard format to CRT-DDS
standard format 48
validating clinical domains 12
validating for compliance with CDISC
SDTM 45
duplicating domains 37

f folder structure 24
folders, default
See default folders

i icons 37, 67
importing
controlled terminology 11
data standards metadata 6
terminology packages 10

l libraries
See default libraries
librefs
consistent use of 26
loading data into domains 44

m metadata
adding annotated CRF and value-level metadata to define.xml file 52
adding value-level metadata to define.xml file 53
importing, for data standards 6
including computational algorithm and
codelist metadata in define.xml file 51
metadata folder structure 24
monitoring domain status 31

o ownership 2
<table>
<thead>
<tr>
<th>Permissions</th>
<th>Standard Domains</th>
</tr>
</thead>
<tbody>
<tr>
<td>Promoting custom domains</td>
<td>Creating</td>
</tr>
<tr>
<td>Custom Domains</td>
<td>Refreshing</td>
</tr>
<tr>
<td>Properties</td>
<td>Status</td>
</tr>
<tr>
<td>Customizing data standard properties</td>
<td>Changing, for compliance checks</td>
</tr>
<tr>
<td>Editing clinical properties</td>
<td>Monitoring domain status</td>
</tr>
<tr>
<td>Editing domain column properties</td>
<td>Maintaining structural consistency</td>
</tr>
<tr>
<td>Modifying clinical component properties</td>
<td>Modifying properties</td>
</tr>
<tr>
<td>Viewing and modifying default folder properties</td>
<td>Monitoring domain status</td>
</tr>
<tr>
<td>Viewing and modifying default library properties</td>
<td></td>
</tr>
</tbody>
</table>

| Refreshing standard domains       | Terminology                       |
| Repairing clinical objects        | See controlled terminology        |
| Column groups                     | Terminology Packages              |
| Controlled terminology packages   | Creating                          |
| Copies of clinical components     | Deleting                          |
| Copies of data standards          | Modifying properties              |
| Domain columns                    | Monitoring domain status          |
| Domain templates                  |                                    |
| Domains                            |                                    |
| Reporting                          |                                    |
| On CDISC-SDTM to CRT-DDS           |                                    |
| Transformation                     |                                    |
| On compliance                      |                                    |
| On validity of define.xml file    |                                    |
| Reports                            |                                    |
| Running and saving                 |                                    |

| Target files                      | Terminology Tables                |
|                                  |                                    |
| Converting study data into       |                                    |
|                                    |                                    |

| SAS Clinical Data Integration    | Validate CRT-DDS transformation    |
|                                  |                                   |
| Prerequisites                    |                                   |
| Workflow                          |                                   |
|                                  |                                   |
| SAS Clinical Standards Toolkit   |                                   |
| Importing controlled terminology from saved data |               |
| SDTM domains                     |                                   |
| Transforming into define.xml file |                                   |
| Security model                   |                                   |

| Unique records                   |                                   |
|                                  |                                   |
| Usage Information                |                                   |
| Analyzing                        |                                   |

| Validate CRT-DDS transformation  |                                   |
|                                   |                                   |
| Clinical Domains                 |                                   |
| Define.xml file                  |                                   |

| SDTM Domains                     |                                   |
|                                  |                                   |
| Sequence Numbers                 |                                   |

| Structural Consistency of Studies|                                   |
|                                  |                                   |
| Studies                          |                                   |
| Consistent use of librefs        |                                   |
| Creating                         |                                   |
| Deleting                         |                                   |
| Modifying properties             |                                   |
| Monitoring domain status         |                                   |

| Subject Sequence Generator       |                                   |
| Transformation                    |                                   |

| Submissions                      |                                   |
|                                  |                                   |
| Consistent use of librefs        |                                   |
| Creating                         |                                   |
| Deleting                         |                                   |
| Modifying properties             |                                   |
| Monitoring domain status         |                                   |

| Trial Manager                    |                                   |
|                                  |                                   |
| Terminology Tables               |                                   |

| Validate CRT-DDS transformation  |                                   |
|                                   |                                   |
| Clinical Domains                 |                                   |
| Define.xml file                  |                                   |

| SDTM Domains                     |                                   |
|                                  |                                   |
| Sequence Numbers                 |                                   |
domains for CDISC SDTM compliance 45
value-level metadata adding to define.xml file 52, 53

W
workflow 2
workflow owners 2
Your Turn

We welcome your feedback.

- If you have comments about this book, please send them to yourturn@sas.com. Include the full title and page numbers (if applicable).
- If you have comments about the software, please send them to suggest@sas.com.
SAS® Publishing Delivers!

SAS Publishing provides you with a wide range of resources to help you develop your SAS software expertise. Visit us online at support.sas.com/bookstore.

SAS® PRESS
SAS Press titles deliver expert advice from SAS® users worldwide. Written by experienced SAS professionals, SAS Press books deliver real-world insights on a broad range of topics for all skill levels.

SAS® DOCUMENTATION
We produce a full range of primary documentation:
• Online help built into the software
• Tutorials integrated into the product
• Reference documentation delivered in HTML and PDF formats—free on the Web
• Hard-copy books

SAS® PUBLISHING NEWS
Subscribe to SAS Publishing News to receive up-to-date information via e-mail about all new SAS titles, product news, special offers and promotions, and Web site features.

SOCIAL MEDIA: JOIN THE CONVERSATION!
Connect with SAS Publishing through social media. Visit our Web site for links to our pages on Facebook, Twitter, and LinkedIn. Learn about our blogs, author podcasts, and RSS feeds, too.